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Notes To Readers
The Quick Designer User Guide provides the following information:

• Setting up a project in Quick Manager

• Using Quick Designer to create panels for a Quick Panel display

• Creating library functions for use with multiple projects

• Setting up alarms and alarm reports for use with a Quick Panel display and a
controller

• Connecting a Quick Panel display to a Computer to download panels

• Connecting a Quick Panel display to a controller

Related Documents
The following documents contain additional information:

• For information on Quickstep, refer to the QuickstepTM

Language and Programming Guide or the QuickstepTM User Guide.

• For information on the registers in your controller, refer to the Register
Reference Guide (available at www.ctc-control.com).

• For information on Microsoft Windows or your PC, refer to the manuals
provided by the vendor or help files.

Book Conventions
The following conventions are used in this book:

ALL CAPS BOLDFACE Identifies DOS, Windows, installation program file names.

Boldface Indicates information you must enter, an action you must perform,
or a selection you can make on a dialog box or menu.

Italics Indicates a word requiring an appropriate substitution.  For
example, replace filename with an actual file name.

Text_Connected_With_Underlines Indicates symbolic names used in Quickstep programs.  Step
Names are ALL_CAPITALS.  Other symbolic names can be
Initial_Capitals or lower_case.

SMALL CAPS Identifies the names of Quickstep instructions in text.
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Notes to Readers

Book Conventions (Continued)

Courier font Identifies step names, comments, output changes, and Quickstep
instructions appearing in the Quickstep editor.

Art Code - DN-24 Identifies the file name of a particular graphic image.

How to Contact Control Technology Corporation
Control Technology Corporation is located in Massachusetts, and we are open
from 8:30 a.m. to 5:00 p.m. eastern time. Contact us at 508 435-9595 and 800
282-5008 or Fax 508 435-2373

See us on the World Wide Web: www.ctc-control.com.

Your Comments
We welcome your suggestions and comments about this or any other Control
Tech document. Comment forms are in the file called BUGRPT.WRI, which was
installed in your QSWIN directory during your Quickstep installation. you can
also email comments to techpubs@control.com.
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Quick Manager is the name of the first window you see when you activate the
Quick Designer program. From Quick Manager you set up a project file and
specify the serial communications attributes and other information required for a
project. From the manager window you access:

• The panel editor, which is used to design panels
• The tag editor to add or modify the tag list
• The alarm manager to setup the alarm processor
• The download button which sends a completed project to a display

The Quick Manager window is shown below.

Toobar
The tool bar contains icons relating to frequently used commands found in the
menu bar. By clicking an icon, you gain instant access to commands. The Quick
Manager tool bar is shown below.

The Quick Manager tools are as follows:

New project Open project setup dialog box

Delete project Compile and download project

Print Project Panel editor

Tag editor Edit and create alarms

Quick Manager Window

QT_1

QD_1
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Quick Manager Window Overview

Store project in panel Compile project

Download project Upload project

Display help file Exit Quick Manager

Menu Buttons
The large menu buttons perform the same functions as the icons in the toolbar.
The menu buttons also resize when the window is resized. The Quick Designer
menu buttons are shown below.

Project File List
The Project File List contains all the projects available to Quick Manager. You
can create multiple projects, each with a different target display. You can copy
and paste panels from one project to another.

Status Bar
The status bar displays operator prompts to aid you in using the manager and
designer tools.

QD_16
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Naming a Project
When you create a new project, you must give the project a name and select a
target display device. To start Quick Designer and create a new project:

1. From the Start menu, select Quick Designer from the Quick Designer
Product group on the Programs menu.

The Quick Manager dialog box appears.

2. Click the New button to display the New Project dialog box.

3. Enter the project name and press the TAB key to move the cursor to the
Display device pull-down selector (the down arrow to the right of the text
field).

4. Select your target device from the display device list.

5. Click OK.

Specifying Project Options
After you have given your project a name, the Project Setup dialog box ap-
pears. The PLC & Protocols section of the Project Setup dialog box already
lists the correct protocol and communications setup for the display. They are
SIO/CN1 and the CTC Binary Protocol.

1. Selecting the More button displays the Additional Project Setup dialog
box. Use the Additional Project Setup dialog box to enter the Author name
and project notes.

Starting a Project and Specifying Options

QT_1

QT_2
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Quick Manager Window Overview

2. Enter the panel developers name and any notes.

Selecting a Display Device
The next section of the Project Setup dialog box is labeled Display Device.

1. Click the down arrow button on the Model list and pick a target display. The
model selected is shown in the Model list box.

2. Click the Display button to bring up the Display Configuration dialog box,
which is used to select the initial screen and the screen saver time-out.

3. In the Initial Screen field enter the name of the first panel you want the
Quick Panel to display.

This is the first panel displayed when the power is cycled. You can re-display
the Project setup dialog box and change the first panel. If you leave the
Initial Screen entry blank, the target display prompts the operator to choose
a panel when the power is cycled. You do not have to specify the initial
screen when you start a project. You can specify it at a later time.

NOTE: If the Initial Screen name does not match a name in the drop-down list box, the display screen
goes black after the panels are downloaded. Choose the initial screen name from the list box to
insure you have the correct name. Panel names are case sensitive.

4. Enter a time out value in the Screen Saver Timeout field. The timer starts
after someone touches the screen. If the screen is not touched again before
the timeout period, the screen goes blank. A setting of 0 will keep the
display on constantly.

QT_3

QD_17
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Specify Touch Screen Configuration
1. Select the Touch button to bring up the Touch Screen Configuration dialog

box

2. Click the Disable Beeper check box with the mouse to turn off the beeper.
The beeper sounds each time an active screen operator is touched. If you are
developing a project in a crowded environment, we suggest you turn the
beeper off as a courtesy to your neighbors.

3. If you have installed an optional keypad, click the Keyboard Attached
check box. If the display type does not have the keypad option, this option is
grayed out.

Selecting Communications Parameters
The Port button displays Serial Parameters dialog box. Use it to setup the
main serial port. This dialog box is one of the most important, because it defines
the communication settings between the display and your controller.

1. Select the Port button to display Serial Parameters dialog box.

The settings MUST match those of your controller and should be set as
follows:

2. Use the Select button to choose RS232C in the Electrical Format field,
then press TAB to move to the Baud Rate parameter.

3. Set the Baud Rate at the 9600 (default) then press TAB to move to the Data
Bits parameter.

4. Set the Data Bits at 8 (default) then press TAB to move to the Parity
selection.

5. Set the Parity at None (default), Stop Bits at 1 (default) and Handshake at
None (default) and click on the OK button.

QT_6

QT_4

Starting a Project and Specifying Options
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Setting the Time-out Duration
The Protocol dialog box is used to select the timeout duration (in seconds). The
CTC Binary Protocol was previously selected from the Project Setup dialog
box. You can return to this dialog box to adjust the configuration as you proceed
through the project.

1. Select the Protocol button to display the Protocol dialog box.

2. Enter the timeout duration (in seconds). You can return to this dialog box to
adjust the timeout duration as you proceed through a project.

Specifying System Configuration Options
The System Configuration dialog box is used to select the panel trigger tag,
watchdog timer tag and duration as well as the compilation method. You can
return to this dialog box to adjust the configuration as you proceed through the
project.

1. Select the System button displays the System Configuration dialog box.

2. You can enter a register number in the Panel Trigger Tag field. The panel
trigger tag allows a register in your controller to control the selection of
panels. You can allow the operator to select panels, the controller to select
panels, or a combination of the two.

Each panel has a unique Panel ID number which is displayed when you save
or open a panel.

When the panel ID number is put in the controllers trigger register, the Quick
Panel displays the selected panel. The panel change occurs only when the
value in the register changes and the change overrides anything else being
displayed. If you leave Panel Trigger Tag field blank, an operator can select
panels using the GOTO PANEL button.

IMPORTANT! Do not use block transfer tag variables for the Panel trigger tag.

QT_5

QT_7
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You can use a combination of panel trigger tag and GOTO PANEL buttons.
The operator can select different panels by pressing a GOTO PANEL button,
and the controller can select a panel by changing the panel ID number in the
Panel trigger register. In this situation, the GOTO PANEL button writes the
panel ID number to the Panel trigger register to initiate the panel change. The
important point to remember is that a new panel is displayed when a change
occurs in the trigger register.

If you use a panel trigger tag, you should also select a Default Panel. If the
panel trigger tag in your controller is equal to 0 or an unused panel ID
number, and you don’t use a Default Panel, the target display screen will be
blank.

3. Enter a register to serve at the watchdog register.

The watchdog is a register in your controller that is periodically checked to
determine if the communication link is still operational. Each timeout period,
the display sends a value to the watchdog register. The controller waits for a
specified period, then checks the contents of the register. If there is a value in
the register, the link is working. The controller then clears the register and
begins waiting again.

4. Selecting the Define Passwords button displays the Password Setting
dialog box. Use it to password protect one or more panels in a project.

You can setup passwords for up to 16 users. The password is a numeric value
from 0 to 65535 with up to three levels of security. For each protected panel
in a project, a security level of Operator, Supervisor, or Master is selected.
During run time when a protected panel is selected, a numeric data entry
panel is displayed prior to accessing the panel. A proper numeric password
must be entered which is equal to or greater than the assigned security level,
otherwise access is denied. The Master level can access all panels.

5. From the Password Setting dialog box you can perform any of the follow-
ing actions:

• Assign a password by selecting an unused line, enter the password and
optional user name, select a password level, then click the Change
button.

• Edit the password by selecting the line, making required changes and
clicking the Change button.

• Remove password assignments by selecting a line, select Unassign and
click the Change button.

QD_163

Starting a Project and Specifying Options
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Quick Manager Window Overview

NOTE: Set the password for a single panel by opening the panel then go to the Settings menu and
select Panel. The Panel Settings dialog box appears. From the password level list box, select
No Password, Operator, Supervisor, or Master.

6. You are now done with the Project Setup dialog box, click the OK button to
return to the Quick Manager dialog box.
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Quick Designer Window
The Quick Designer window is used to create and edit panels for each project.
To open the Quick Designer window:

• Select Panels from the Components menu

• Click the Panels button in the Quick Manager window or click the Panels
icon on the toolbar

Using the Right Mouse Button
If you click the right mouse button while the cursor is in the grid area, it displays
a combination menu. The options in this menu include: Undo, Redo, Paste,
View, Panel, Grid and Preferences.

Menu Button Toolbar
This toolbar contains icons relating to commands found in the menu bar. By
clicking an icon, you gain instant access to frequently used commands. You can
turn off the Button Bar by unchecking the selection in the Options menu.

Creates new panel Opens existing Panel

Saves active panel Checks active panel for errors

Designing a Panel: Quick Designer Window

Menu Bar - contains menus that give
you access to all the Quick Designer
window functions

Title Bar - displays the application, the panel name, and project name.

Menu Button Toolbar - contains icons
relating to commands found in the
menu bar. By clicking an icon, you
gain instant access to frequently used
commands. You can turn off the
Button Bar by unchecking the
selection in the Options menu.

Status Bar - contains context sensitive
status information. The information
changes are based on the location of
the mouse and mouse selections. You
can turn off the Status Bar by
unchecking the selection in the
Options menu. The center field of the

Panel Display - displays the panel
elements as you design and edit
them. The panels are then
downloaded to the Quick Panel
display.

Tool Box - contains the design
tools used to create a panel.status bar shows the coordinates of the mouse as it is moved

around the panel. The right field shows the view percentage. A 1:1
view is 100%.

QT_41

QD_24
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Undo last operation Redo the last undo

Cuts an item and places it on the clipboard

Copies an item and places it on the clipboard

Pastes an item from the clipboard

Creates or updates a library object

Aligns the selection with an object or position

Changes the attributes of a object

Deletes selected object

Moves object to background

Brings object to foreground

Zoom in Zoom out

Quits Quick Designer and prompts for save

Toolbox Design Tools
The editor presents you with a box of panel operator design tools. You select one
of the operators from the tool box and place it on the screen. Some operators
require the number of a register or flag to make them active. Some operators are
for internal use, such as the GOTO panel, which is used to move from one panel
to another. The pointer is a special tool, used to select objects already on the
screen.

Pointer Polyline

Text tool Bitmap tool

Circle Rectangle

Legend plate Push button

Illuminated push button Print button
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Word button Pilot light

Message display Image display

Selector Switch Goto panel

Numeric display Numeric entry

Time display Bar graph

Trend display Analog meter

Alarms Video display

Designing a Panel: Quick Designer Window
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Basic Panel Operators
A basic panel operator can be a push button, pilot light, illuminated push button,
selector switch, or any type of operator control mechanism typically found on a
control panel. The Quick Designer editor allows Windows user to easily create
basic panel operators and group them in panels.  When the design project is
completed in Windows, you can transfer the project file to a Quick Panel dis-
play. Using the editor and display combination, you can quickly create and
modify a custom control panel for your controller.

The 5 inch and 6 inch Quick Panel displays are 320 x 240 pixels, which is
divided into 24 cells of 80 x 40 pixels.

The pixel arrangement  for other size displays are as follows:

• 9 inch display is 640 x 400 pixels divided into 80 cells
• 10.5 inch display is 640 x 480 pixels divided into 96 cells
• 12.1 inch display is 800 x 600 divided into 150 cells

For beginners, the editor draws a panel operator in a  two cell field. The opera-
tors can be resized to a single 80 x 40 cell or the entire screen. In the drawing on
the next page, a pilot light operator has been placed on the screen.

240 Pixels

320 Pixels
80 pixels

40 Pixels

Designing a Panel: Basic Panel Objects

QT_9
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Once the operator appears on the screen, an edit dialog box appears. In the case
of the pilot light, you can change the text size and color, change background and
outline color, and assign a register or flag to control the light.

Each type of operator can be customized to fit a wide range of applications. It
therefore becomes very easy to place an operator on the screen, modify it for
your application and load the project into a Quick Panel display.

Core Components
Core components are the basic building blocks that will allow you to configure
the Quick Panel operators. These core components will be used in the creation
of the basic operators like push buttons, pilot lights, illuminated push buttons,
and selector switches.

Bezel

Legend plate

QT_36

The bezel presents a visual indica-
tion to the operator that the button
has been pressed. The bezel, bezel
outline, and touch color can be
changed to suit your application. The
example shows the bezel in two
colors. A bezel is used with a touch
button such as Push Button, Illumi-
nated Push Button, Goto Panel
Button and Numeric Data Entry
Button.

The legend plate is used to provide text information
to the operator. The text size can be changed, and
the text automatically centers itself both vertically
and horizontally. The text color, background color
and outline color can be modified for your applica-
tion. Legend plate information is static. Legend
plates are used with Legend Plates, Push Buttons,
Goto Panel Buttons, Numeric Data Display Buttons
and Numeric Data Entry Buttons.

Designing a Panel: Basic Panel Objects

QT_38

QT_37
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Lens

Readout
A numeric readout provides a mechanism to display
the contents of numeric registers.

QT_39

QT_40

The lens presents a visual indication to the operator
of the current status of one of the controllers flags.
The lens is typically presented as a pair of functions,
usually an OFF lens and an ON lens. Text in the
lens is used to describe to the operator what the
status of the flag means. Text size is variable and
automatically centers itself both vertically and
horizontally. The text color, lens color, and outline
color can be changed to suit your application.
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Introduction to Tags
A tag is the name Quick Designer uses for the flags, registers and data table
entries, in your controller. Using the special registers in your controller, you can
access the other resources in your controller. For example, to turn a pilot light
off and on using an output, you can access registers 1001 through 1999 which
give you access to the controller’s outputs. For more information on controller
registers, see the Register Reference Guide, available from the customer area of
Control Tech’s web site.

Tag names are as follows:

• Registers are R or r and the register number. R100 refers to register 100.

• Flags are F or f and the flag number. F17 refers to flag 17.

• Data table row and column are D or d and row,column. D7,15 refers to row
7 column 15.

NOTE: Tag names are case sensitive. R100 and r100 read the same data from register 100 in the
controller but each is considered a separate and distinct variable in the Quick Panel display.
Tag names for flags can begin with F or f, and data table row and column can begin with D or
d. You must be consistent when using tag names.

Every panel operator that is active requires at least one external tag. The display
reads the tag information from the controller. You can also create internal tags,
which are variables that are controlled and contained within the display. Internal
tags are also explained in the this chapter.

Displaying the Tags Window
To display the Tags window:

• Select Tags from the Components menu.
• Select the Tag icon from the toolbar or the Tags menu button.

The Tags window appears. From this window you can add new tags, view tag
attributes, import and export tag files, and delete tags.

Designing a Panel: Using External Tags
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Quick Manager Window Overview

Adding Tags
1. To create a new tag, select Add from the Tag menu or select the ADD

button.

The Tag Create dialog box appears

2. Enter the tag name. Tag names are tested to insure they are valid.

To create a contiguous group of tags by use the Auto button to generate a list
of tags that have a common name and span a given range. Instead of typing a
long list of tag names that all appear the same except for the last numbers,
you can automatically generate the list.

3. Enter the common tag name in the Tag Create dialog box and click the Auto
button.

The Automatic Tag Create dialog box appears.

4. Enter the count and press OK to automatically generate the list. For ex-
ample, if the starting address was F10 and the final address is F14, you
would enter the count as 5.

5. When the Tag Create dialog box appears, select OK to create the tags.

Editing the Tag List
Deleting and Un-deleting Tags
1. To delete a tag from the list

a. Click the tag to highlight it
b. Select the Delete button.

2. To un-delete the tag, select Undelete from the Tag menu.
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To purge all tags from the project list, click the Purge button. Use caution with
this button since the operation removes all tags.

IMPORTANT! Purging ALL tags from a project removes all tags!

Specifying Tag Attributes
Tags can have attributes, such as type and range. Assigning attributes to a tag
allows you to customize the tag to a particular application. For example, you can
scale a tag so that when the data is displayed, a scaled range is displayed. You
can view the attributes of a tag by selecting Attributes from the Tag menu or by
double-clicking the tag name. The three sections of the tag attributes menu are
Names, Type and Ranges.

Importing and exporting Tag Files
You can save the information in a Tag file by exporting it using the *.tag format.
You can also import tags saved in *.tag format. Do not use a word processor to
create or modify *.tag files.

Tag Validation
You can validate the entire tag list by selecting Validate Tags from the Tools
menu. The process is displayed in the Tag Validation Progress dialog box.
Internal tags are displayed in a list box.

Names - shows the name of the Tag.
The Var name is for internal use and
cannot be changed.

Type - indicates the type setting and
other attributes of the tag variable. The
default setting for tags is Integer.
Set the type to String when reading
ASCII characters. Specify the length of
the string in the size entry box.

This part of the screen is inactive and
intended for a future option.

Range - specifies the allowable the range of the variable. The ranges are automatically set for each tag type.
By changing the scale ranges, you change the ratio of the input value to the displayed value. In the following
example, if you changed the Scale low to 0 and the Scale high to 100, when the Input value is -32768 the
displayed value would be 0, and when the Input value is 32767, the displayed value would be 100.

QD_23
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Quick Manager Window Overview

Designing a Panel: Using Internal Tags
Using internal tags, you may have an internal storage register, to store some
values or act as a temporary counter. You can create an internal tag by entering a
tag name that is not valid for your controller. For example, if you entered the
name COUNT1 as a tag name, the tag editor asks if you want to create the tag as
an internal tag. Answering yes, creates an internal tag that you can read and
write to in the same manner as an external controller tag.

System Tags
Your Quick Panel display has several support functions designed into the
hardware that use internal tags, such as the clock. The names of the tags that are
designated system tags all begin with a tilde (~) and the word System. There is
also an underscore symbol between the word System and the name of the tag.
You must always specify the name of the tag exactly as it appears below. For
example, when displaying system seconds, the tag name is ~System_Second. If
you enter a tag name as Second, the target display creates an internal variable
called Second, but it is not connected to the internal clock.

Current supported system tags are as follows:

• ~System_Second Internal clock seconds
• ~System_Minute Internal clock minutes
• ~System_Hour Internal clock hours
• ~System_Day Internal clock day
• ~System_Month Internal clock month
• ~System_Year Internal clock year
• ~System_Contrast LCD panel contrast setting
• ~System_Comm_Status Communication Status

Using system variables you can perform the following functions:

• Display the system time
• Display the date or use the variables for a date stamp
• Adjust the contrast of your screen
• Display the status of the communication protocol

Clock Operator Variables
One of the tools available to the panel designer is a Clock operator. The method
used to connect the Clock operator to the hardware clock is a series of internal
tags called system tags. The Clock operator is connected to three system tags,
which supply the data for seconds, minutes and hours. The tags are called
~System_Second, ~System_ Minute, and ~System_Hour. See Chapter 6, Creat-
ing Panel Objects, for information on setting the internal clock.

Date System Variables
The Quick Designer software includes a tool for creating an alarm display. One
of the options in the alarm message is the display of a date stamp. The tags are
called ~System_Day, ~System_Month, and ~System_Year. The method for
setting the correct date is similar to setting the time. See Appendix B, Using
System Variables, for more information.
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Contrast System Variable
Using the system variables and internal tags, you can change the contrast of the
target display to suit different viewing conditions.  To adjust the contrast, the
system variable ~System_Contrast must be set to a value from 1 to 7. This can
easily be done by using two Word Buttons: one to increase and one to decrease
the value of ~System_Contrast. You can see the contrast change as the value is
increased or decreased. See Appendix B, Using System Variables, for more
information.

Communication Status
The communication status is a bit that can be used to turn a pilot light on or off
to indicate the status of the communication protocol. When the bit is equal to 0,
the communication protocol is normal. The tag variable is
~System_Comm_Status. See Appendix B, Using System Variables, for more
information.

NOTE: ~System_Comm_Status is an internal tag that is available only on QPJ-1 and QPI-1 models.

Designing a Panel: Using Internal Tags
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Creating Panel Objects
To create a panel object:

1. Point with the arrow cursor to the desired icon in the Tool box and click the
mouse. When the cursor is moved into the screen area, a cross hair appears
with a small image identifying the type of tool selected. Shown below is the
Legend Plate tool. The status bar on the bottom of the window indicates
which tool you selected.

2. Move the cross hair to the desired cell and click the mouse. Most objects
will appear across two cells.

3. If you want to size the object immediately, move the cross hair to the desired
cell, click and hold the mouse button and drag the mouse to size the object.
Release the mouse button and the object is sized.

A dialog box for the selected object appears.

The object can be placed on the panel in several different modes, based on
the selections in the Settings/Preferences dialog box. The dialog box that
appears depends on the type of object selected. When the dialog box for a
selected object is active, a dashed box appears around the object. The
example shows a legend plate object placed on the screen. The dialog box for
the legend plate allows you to select the legend plate text, text size and color,
background color and outline color. Dialog boxes may contain buttons that
open additional dialog boxes.

4. When the dialog box selections are completed, click the OK button.

Editor Basics
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Editing a Panel Object
When you create a panel object, the dialog box for that object appears. To
change the attributes of the object, double-click the object to display the dialog
box. You can also display the dialog box by selecting the Change option in the
Edit menu.

You can delete the object by selecting it, then pressing the Delete key or select-
ing the Delete option in the Edit menu. You can delete a group of objects by
pressing and holding the left mouse button and drawing a box around the objects
to be deleted.

When you are done designing a panel, use Save in the File menu to save the
panel. Select New to start a new panel. Continue building and saving panels
until your project is complete. When you have completed designing all panels,
exit Quick Designer and return to Quick Manager to download the project to the
target display.

Grouping objects
Two or more objects on the panel can be grouped together so that they will act
as a single object. Use the Select All option on the Edit menu to select all objects
for grouping. You can select several objects by clicking them or drawing a box
around them while holding the left mouse button. You can select multiple
objects by holding down the Shift key and clicking the objects you want
grouped.

Select Group Objects from the Edit menu (shortcut CTRL+G) to maintain the
grouping.

Once you have grouped objects, you can use commands such as move, delete,
library file, copy as if they were one object. When objects are grouped using the
Group Objects selection, they remain grouped until you ungroup them using
Ungroup Objects.

Sizing an Object
You can make panel objects larger or smaller. When sizing objects, the selec-
tions you make in the Grid Settings and Preferences dialog boxes affect how you
can size objects. All objects (except draw objects) have outlines for resizing.
When you select an object, the outline first changes to a dashed outline and
sizing handles appear. When you touch one of the sizing handles, the object
outline changes to solid lines. The solid outlines aid in sizing the object exactly
the way you want it.

To make a small pilot light, turn off the snap size to grid option in the Grid
Settings dialog box.

To size panel objects:

1. Move the cursor over an object and click the left mouse button. Dashed lines
around the object indicate it is selected. Moving the cursor inside the dashed
lines will change the cursor into a move symbol. Press and hold the left
mouse button to move the object.
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2. Move the cursor to one of the sizing handles (small boxes on corners and
centers of edges). Sizing handles in the centers of the edges allow sizing
vertically or horizontally, while corner handles allow diagonal sizing. The
cursor will change to a double ended arrow when you are on top of a sizing
handle.

3. Click and hold the left mouse button and drag the sizing handle in the
direction selected. Click the mouse outside the dashed lines to deselect the
object.

Object Tag Display
You can view the object tag by enabling the option in the View menu. The
illustration shows the tag names displayed in the upper left corner.

Keypad Tag Display
The keypad tag display is similar to the object tag display. The keypad tag
operates independently of the object tag display. The keypad tag is displayed in
the bottom left corner of the operator and provides a quick visual check to see
which panel operators have keypads assigned. The keypad tag appears with a
panel print. You can view the keypad tag by enabling the option from the View
menu.
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Changing the Window View
You can change the view in the window from a zoomed out view of 50% to a
zoomed in view of 800%. Select Zoom options from the View menu. Zoom
buttons are provided for fast view changes.

Previewing Panels
You can see what the panel will look like on the target display by selecting
Preview from the View menu. A 1:1 full screen view is displayed.

Importing and Exporting Panels
If you create a custom panel for Project X and you want to use the identical
panel for Project Z, the panel can be exported to an external file format and later
imported to a new project. The exported panel objects have tag variables that
were assigned in Project X. When you are working on a different project, the
custom panel is first imported. The tag variables for each object can then be
changed, if necessary, to match the new project. The panel is then saved with the
modified custom panel.

1. Open the Quick Designer program and then open the panel you want to
export.

2. Select Export from the File menu and export the panel using a DOS
filename. The file will be given the *.pnl extension.

3. Exit Quick Designer and return to Quick Manager.

4. Create a new project or select an existing project.

5. Activate Quick Designer and select Import from the file menu.

6. Import the desired panel.

7. Save the panel using a new panel name.

8. Change the tag variables for each object if necessary.

9. Save the panel for the new project.

10. Continue to import or design other panels until the project is complete.

Saving a Panel
Save As saves the current panel using a new file name. When saving a panel
under a new name, you can specify a panel ID. The panel ID is the identification
number that can be used by a controller to select a panel. When the panel ID
number is written to the panel trigger tag register in the controller, the Quick
Panel displays the associated panel. The panel trigger tag is selected in the
Quick Panel Configuration dialog box. Quick Designer automatically assigns the
panel ID when the panel is created. You can change it to any number up to 8999.
Panel ID numbers must be unique within a project.

Checking a Panel for Errors
Check the panel design for potential errors. Errors are reported in a dialog box,
and you will have the option of ignoring one or all errors. Error checking is
automatic each time you save a panel.
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Aligning Objects
Align object option aligns the selected object to a vertical or horizontal coordi-
nate. To align panel objects:

1. Select the object, then select Align from the Edit menu (Shortcut Ctrl + A).

A cross hair cursor appears on the screen. The cursor position information
box is located in the bottom, right corner of the screen.

2. Move the cursor to the desired position and click the left mouse button.

The Align Object dialog box appears.

3. Select Horizontal or Vertical alignment.

4. Click OK and the object will be aligned to the selected coordinates.

Grouping and Ungrouping Panel Objects
Two or more objects on the panel can be grouped together so that they will act
as a single object. You can use Select All option on the Edit menu to select all
objects for grouping. You can select several objects by clicking and holding the
left mouse button as you draw a box around the objects or select multiple objects
by holding down the SHIFT key and clicking the objects you want grouped.

Once you have chosen the panel objects you want grouped, select Group Object
from the Edit menu (Shortcut CTRL+G) to maintain the grouping.

Once you have grouped objects, you can use commands such as move, delete,
library file, copy on the grouping.

Objects remain grouped until they are ungrouped by selecting Ungroup Objects
from the Edit menu (Shortcut CTRL+U).

Changing Panel Object Tags
Change Object Tags (shortcut Ctrl+T) modifies the tag attributes of a selected
object or group of objects. The Modify Tag Attributes dialog box appears.
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You can edit the address by clicking the name and typing a new name. To enter
edit mode, double click he name. To leave edit mode, press the ESC to undo the
edit mode. Select a different address by clicking the down arrow to display a list
box.

The prompt field is used to enter a description of the tag. The prompt will appear
in any settings dialog box where the tag is used. You can edit the prompt text the
same way you edit the Address text. The example shows the prompt text in the
Pilot Light Settings dialog box.

You can also enter a new tag prompt by double clicking in the area above the tag
field. Enter the prompt and press return.

Preferences
Quick Designer is set up to allow the novice user to quickly design panels. Some
of the operations appear automatically, such as deselecting a tool after using it
and automatically checking the panel when the file is saved. Some of the auto-
matic operations can be turned off. If you are a beginner, most of the automatic
operations are turned on. The intermediate level turns off a few of the automatic
operations. The Advanced level allows you to pick the automatic operations you
prefer.

• New at startup: Opens a new panel when Quick Designer starts.

• Tool de-select after use: When you are done using an object, the cursor will
change to a pointer. If this box is not checked, the cursor remains the same
as the last object selected.

• Check panel on save: The panel design is checked for errors when SAVE is
selected.

• Warning: Overlap Check: Warns that objects are overlapped on the panel.

• Panel settings on New: Displays the Panel Settings menu when a New file
is started. Allows selection of black or white panels.

• Change after object create: When an object is placed on the panel, a dialog
box will appear. The dialog box is used to change settings for the object. If
the box is not checked, the object is placed on the panel without the dialog
box.
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• Object de-select after use: When you are done working with an object, it
remains selected, indicated by a dashed line around it. Checking this box
will de-select the object after using it.

• Auto move on object select: You can select and move an object by clicking
it and holding down the mouse button as you move it.

• Object to fore after move: Places the object in the foreground after it is
moved.

Dimming Flashing Colors
When you are creating panels, you have the option of selecting flashing colors.
Flashing occurs only when the panel has been downloaded to a target display. To
see which colors have been selected as flashing, check the Dim Flashing Colors
option in the View menu. Flashing colors then appear as a different shade, or a
dimmed version of the corresponding color.

Changing Panel Settings
You can change the background color of the Quick Designer panel. The default
setting is black. The following dialog box is for color units.
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Keypad Assignments
When you create a panel, you also have the option of assigning keys on the
keypad to simulate panel buttons. You assign keys at the same time you create a
panel. The Keypad Assignment dialog box has a list box for displaying the
keypad assignments and a series of buttons for creating simulated operators,
such as a simulated push button. See Chapter 7, Keypads, for more information
on keypads and keypad assignments.

You can assign a keypad to simulate a panel object, even though there is no
panel object visible on the screen. You can assign one of the keypads to simulate
the following panel operators:

• Push Button
• Goto Panel Button
• Print Button
• Word Button
• Selector Switch
• Numeric Data Entry

You can view all the keypad assignments by clicking the down arrow in the Key
list box. A keypad assignment list appears. You can change the attributes of any
simulated operator by selecting the keypad from the list, then clicking the
Attributes button. Simulated operators are marked as Simulated. To change the
attributes of normal operators assigned to keypads, you must use the panel editor
and double-click the operator.

1. To assign a keypad operator, select Keypad Assignments from the Tools
menu.

The Keypad - Key Assignments dialog box appears.

2. To select which keypad is assigned to the simulated panel operator, click the
down arrow in the Key list box and select an unassigned key.

3. Select one of the operators to simulate by clicking a button in the Key
Assignment area.

When you click one of the simulate keys, the rest of the buttons are grayed
out.
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4. Select the Attributes button to display the setup dialog. A Goto Panel dialog
box is shown below.

The Bezel, Legend, Make Default and Advanced options are disabled
(grayed out).

5. Enter the panel name and click OK.

When you download the project file to a Quick Panel (with the Keypads option)
the keypads can simulate a panel operator. For example, if you press the A0
keypad, which was selected to simulate a Goto Panel, the panel name you
selected will be displayed. This is the same operation as the goto panel button,
but without the panel operator taking up screen space.

Keypad Assignments
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Tiling and Drawing Grids
The Quick Panel Jr. display is approximately 4 inches wide by 3 inches high. A
pixel is a dot of light on the display panel. The Quick Panel Jr. display is made
up of 320 horizontal by 240 vertical pixels. Each dot has a unique address,
specified by a horizontal and vertical coordinate. The origin is located in the
upper left corner of the display and is designated (0,0). The opposite corner is
the maximum pixel position, designated (319,239).

This drawing shows the two corners of the display with the pixels greatly
enlarged.

Touch Grid
The touch screen is made up of cells that are 20 pixels on a side. The touch cells
share the same coordinate system as the display. The first touch cell uses the
pixels from coordinate (0,0) to (19,19). There is no physical display of the touch
grid. You cannot change the number of pixels in a touch cell. The drawing shows
the first touch grid with only the outline pixels.

Part Objects
There are two types of part objects:  those associated with touch regions and
those not associated with touch regions. A push button is an example of an
object associated with a touch region. A pilot light is an example of an object not
associated with a touch region. Part objects associated with touch regions always
occupy a complete touch cell. All touch objects must occupy a minimum of four
touch cells.
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Tiling and Drawing Grids

Tiling Grid for Objects
The tiling grid is a series of cells used to assist the designer in placing objects on
the display.  The tiling grid can appear as dots, lines or boxes. The cells appear
only in the editor and not on the target display. Objects can occupy more than
one cell since the cells are only a layout guide. The default size of each cell is 80
pixels wide by 40 pixels high.  The first cell origin point is located at (0,0) and
the opposite corner is located at (79,39).

A cell size of 80 x 40 pixels corresponds to 8 touch cells. The drawing shows a
tile cell of 80 x 40 pixels and 8 touch cells.

The following drawing shows the tile grid for a Quick Panel Jr. display.

Tiling Snap System
Another aid for placing objects on the panel is the snap feature. When placing an
object on the tiling grid, the upper left corner of the object will snap to the upper
left corner of a tiling cell. The remaining corners of the object attempt to come
as close as possible to the snap points of the other cells. The object is restrained
from snapping to the other cells in order to remain within the cells they occupy.

Snapping to grid points forces the object to be sized to the dimension of the cell.
In some cases, the object may cover up the tiling grid. Objects that are associ-
ated with touch areas will first attempt to size themselves to complete touch
regions. If the tiling grid is not an even multiple of the touch grid, part objects
associated with touch areas will size differently than other part objects. Remem-
ber that touch areas are 20 x 20 pixels and touch objects must occupy a mini-
mum of four touch areas (40 x 40).
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Objects on the panel  can be aligned to the grid using the snap feature. When
moving an object, the nearest grid line will be the snap point. If you turn off the
snap position option, objects can be placed close together and in some cases
overlap.

Default Settings
The default settings for the tiling grid and snap are selected with the novice user
in mind. These settings make it easy to quickly design a panel. The user selects a
part object from the tool box and places it on the panel. The part snaps to a cell
location and is drawn automatically. One mouse click for a part object to be
created, sized and placed on the panel. The grid and snap system allows the user
to create objects whose edges align and vertices intersect.

Drawing Grid
The drawing grid is a series of equally spaced horizontal and vertical dots used
to assist the user in placement of objects on the display. Each grid point is a
single pixel. The default setting is 10 x 10, which is a dot every ten pixels in
both directions. The grid appears only in the editor but not on the target display.
Object can overlap the points as they are only a drawing aid.

Drawing Snap System
The drawing snap system uses the drawing grid for locating snap points. When
creating a draw object, a grid point nearest the mouse becomes the snap point.
For example, if the grid is set to 5 x 5, and the mouse is located at position (4,4),
the nearest snap point is (5,5). The snap feature and drawing grid can be turned
off.

Grid Settings Dialog Box
You can change the size and style of the tiling grid in the Grid Settings dialog
box. The tiling grid can be dots, lines, or boxes, and can be turned off. The
drawing grid is always dots. The drawing grid can also be turned off. The snap
option can be turned off for both the tiling and drawing grids.
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You can print out the summary information and panel images for all or part of a
project. Selecting Print from the File menu displays the Report Setup dialog
box. From this dialog box you can select the reports you want to print.

Project Information
The following pages show a sample project information report.

PROJECT1
PROJECT INFORMATION
PROJECT: PROJECT1
Author: name
Created: 08 April 1999
Last Modified: 25 June 1999

TARGET DEVICE : QUICK PANEL Jr. Color
Default Panel Name: Panel 1
Screen Saver Timeout: 1.00 minute(s)
Printer Type: NEC PR201 24 DOT
Printer Color Mode: Gray Scale
Black/White Reversed: Yes
Save to FLASH ROM: Yes
Beeper: Off
Watchdog Tag: None
Watchdog Timeout: 0.00 second(s)
Communication Setting: RS232C
Baud Rate: 9600
Data Bits: 8
Parity: None
Stop Bits: 1
Handshake: None

PROTOCOL:  CTC Binary Protocol
Timeout(sec): 1.00

Printing Project Information
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Panel Information
The panel information report lists the name of the panel, the panel ID and all
panel objects along with their attributes. The following list is a sample panel
information page.

PROJECT1
PANEL: PANEL1
A bitmap image of the panel is printed at the top of each panel information sheet.
PANEL: PANEL1
Panel ID: 1
Panel Size: 320 x 240
Grid Size: 80 x 40
Grid Display: Boxes

Illuminated Push Button
Position Size Button/Light Tag Action Bez Botl Tch Sixt Slen Sotl SFont Sjustify State Text
KeyPad Touch Simulated

240,160, 80,80 F27 Toggle blu wht wht wht blk wht 5x7 cc Conveyer OFF
F27 blk wht blk 5x7 cc Conveyer ON

None Yes No

180 Meter
Position Size Tag Bclr Fbkr Fotl Sclr Sfont Scale Text Scale Range NFont Dig,Dec Ticks

0,160, 80,80 R259 blu wht blk vlk 5x7 Pressure 0,212 5x7 4,1 11

Time Display
Position Size Hours Minutes Seconds Military Txt Len Otl Font Justify Format

0,120, 80,80 On On On Off bluf wht blk 5x7 cl 12:00:00 AM

Tag Information
The tag information report lists all of the tags used for the project sorted and
printed by tag name. The following list is a sample tag information page.

PROJECT1
TAG INFORMATION
Tag Information Sorted by Tag Name
Name I/O Elements Type Size Scale Range Low Scale Range High

F10 F10 1 integer 1 0.000000 1.000000
F11 F11 1 integer 1 0.000000 1.000000
F27 F27 1 integer 1 0.000000 1.000000
R126 R126 1 integer 1 -2,147,483,648 2,147,483,647
R200 R200 1 integer 1 -2,147,483,648 2,147,483,647
R259 R259 1 integer 1 -2,147,483,648 2,147,483,647
~System_Hour ~System_Hour 1 integer 1 0.000000 23.000000
~System_Minute ~System_Minute 1 integer 1 0.000000 59.000000
~System_Second ~System_Second 1 integer 1 0.000000 59.000000
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Alarm Information
The alarm information report lists all of the information for the alarm configura-
tion, queue setup and alarm file. The following list is a sample alarm informa-
tion page.

PROJECT1
Alarm INFORMATION
ALARM CONFIGURATION
Message Column: 16
Trigger Date Stamp Column:  1
Trigger Time Stamp Column:  10
Acknowledge Time Stamp Column:  37
Clear Time Stamp Column:  44
Date Format:  MM/DD/YY
Time Format:  24 Hour
Assume Initial State:  Same
Printer:  None

Active Queue:  On
Size:  10
Font:  7x9
Trigger Text - Text Color: blk, Background Color: wht
Acknowledge Text - Text Color: wht, Background Color: blk
Cleared Text - Text Color: wht, Background Color: blk

Historic Queue:  On
Size:  10
Font:  7x9
Trigger Text - Text Color: blk, Background Color: wht
Acknowledge Text - Text Color: wht, Background Color: blk
Cleared Text - Text Color: wht, Background Color: blk

Logged Queue:  On
Size:  10
Font:  7x9
Trigger Text - Text Color: blk, Background Color: wht
Acknowledge Text - Text Color: wht, Background Color: blk
Cleared Text - Text Color: wht, Background Color: blk

Banner Queue:  On
Size:  10
Font:  7x9
Trigger Text - Text Color: blk, Background Color: wht
Acknowledge Text - Text Color: wht, Background Color: blk
Cleared Text - Text Color: wht, Background Color: blk

SYSTEM TAGS
Individual Acknowledge: None
Global Acknowledge: None
Individual Erase:  None
Global Erase:  None

Printing Project Information
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Quick Designer Library Window
The Quick Designer library allows you to create an object, like a pilot light,
bitmap, or selector switch and save the object in a library folder. Later, when
you want to make a copy of the object, the library feature allows for fast and
easy selection and transfer of the object to your panel. You can create templates
for panels and store all the objects as one file in a folder. You can design a
complete panel and store it in a folder in the library. The library has the follow-
ing features:

• Objects and groups of objects can be stored in folders in multiple libraries

• A Drag ‘n Drop feature for fast panel design

Selecting Library Browser from the Options menu will display the Quick-
Designer Library window. The tool bar contains icons for creating new librar-
ies and opening an existing library. There are icons for cut, copy and paste. The
window displays the contents of the current folder. You can select a different
folder and any item within the folder using the drop down list boxes.

• Library: Creates a new library, opens an existing library, or exits the Library
Browser

• Edit: Cuts, copies, and pastes the contents of a library.
• View: Displays the Toolbar
• Browser: Allows you to change the properties of the Library Browser
• Folder: Creates folder to store library objects.
• Objects: Allows you to transfer library objects from one folder to another, delete

library object from a folder and change their properties.
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Browser Properties
The Browser Properties dialog box allows you to change the properties of the
Library Browser. The properties are arranged in a file box format. The tabs are
as follows:

• Drag ‘n Drop: You can disable the drag ‘n drop feature by unchecking the
box. When an object is dragged from the library to a panel, the Quick
Designer editor floats to the top. You can disable this feature by clicking No.

• Appearance: You can change the spacing of objects by entering a new value
in the selection box. The default setting is 3.

• Text Colors: Select the text color and background color for the library
objects name.
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Folders
Folders provide a convenient way of storing objects that are related in some way.
You may want to store all push buttons in a folder, or panels from a project. You
can copy objects from one folder to another and copy the entire contents of one
folder to another.

• Adding Folders: Enter the name of the new folder in the Add Folder dialog
box.

• Transferring Library Objects: Transfer is used to move the contents of the
current folder to another. Select the library destination and the folder name
and click OK.

• Deleting Folders: Deletes the selected folder. A confirmation dialog is
presented. Click Yes to delete the folder.

• Folder Properties: The properties are arranged in a file box format. The
name tab allows changing the name of the folder.
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Library Objects
You can move, delete, and specify the properties of library objects.

• Transfer Object: Moves the selected object to a new destination.  Select the
destination library and folder, enter the name of the object and a description
and click OK to complete the transfer. This is the same operation as copying
and pasting an object.

• Delete Object: Deletes the selected item from the library. A delete confir-
mation dialog box appears. Click Yes to delete the object or No to abort the
delete operation. There is no UNDO.

• Object Properties: The properties are arranged in a file box format. The
Name tab allows you to change the name and description of the object.
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Creating and Using Library Objects
To create a library object, you must have Quick Designer open and be in the
process of creating a panel. In this example we will create an legend plate.

1. To open Quick Designer Library select Library Browser from the Options
menu.

2. When the Library Browser window appears, select New from the Folder
menu.

3. Enter the name of the new folder in the Add Folder dialog box and select
OK.

4. Select Exit from the Library menu to exit the Quick Designer Library.

5. To save the legend plate in a library, click the legend plate to select it

6. Select Store Library Object from the Edit menu.

The Transfer Library Object dialog box appears. It displays the selected
object in the source box. The right side of the dialog box determines the
destination.
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7. Select a folder (You need to have created this folder earlier.) and type in the
name of the object. There is an additional text input box for a description of
the object.

8. Select OK when done.

The Transfer Library Object dialog box closes and the Quick Designer
Library window stays open. Select the Legends folder and the legend plate
with a description should appear.

The Library function supports drag-and-drop, so that you can just select the
object in the library by clicking and holding down the mouse button, then drag
the object from the library to the panel. Once the object is on the panel, the
setting dialog for that object appears. The custom legend plate can be placed on
any panel by opening the Library Browser, selecting the folder, then dragging
and dropping the desired object.

Quick Designer also supports grouping objects. You can select multiple objects
that will act as a single object for moving, sizing, and other editing operations.
The grouping can be temporary, as when you select multiple objects with the
SHIFT key or by drawing a box around objects with the mouse. Objects that are
temporarily grouped can be made permanently grouped by selecting Group
Objects from the Edit menu. Grouped objects can also be stored and retrieved in
the Library.
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Introduction
Alarms are messages that appear on the display in response to a specific condi-
tion in the host control system. The alarm message informs the operator of a
condition that requires immediate attention. A typical alarm message is shown
below.

DATE  TIME  MESSAGE                  ACK   CLEAR
09/18 22:48 HIGH TEMPERATURE ALARM

When creating an alarm display, the first procedure is to configure the alarm
manager. You create a table of controller addresses and enter the alarm text for
each table entry. The alarm manager reads data from the host and determines if
an alarm condition exists.

You select the format for the alarm message, date stamp and time stamp. You can
change the size and format of the queues (buffer area) where the alarm messages
are stored. When alarm messages exceed the size of the queue, the oldest alarm
messages are deleted. You can select a register or flag that will be set when the
alarm acknowledge and delete buttons are used. The alarm table and configura-
tion information are saved in an alarm file.

For each alarm condition, the alarm manager creates an alarm message string.
The alarm manager adds date and time stamps and the alarm text from the alarm
table It also formats the entire alarm message and stores the alarm message in
the active alarm queue (buffer area). The alarm manager keeps track of when the
alarm was acknowledged and cleared and stores this information in the historic
queue. The alarm manager also tracks every alarm activity in a logged alarm
queue.

Once you have configured the alarm, the second procedure required to view
alarms is creating an alarm window. The alarm window is a tool, similar to other
tools, like pilot lights and push buttons. The alarm window is placed on a panel
and is used to view alarm information from a selected alarm buffer. If the
operator touches the alarm window,  the alarm manager screen is displayed. This
screen allows the operator to acknowledge one or all alarms, clear one or all
alarms, or view any alarm message stored in the alarm buffer.

The maximum number of alarms for a project depends on the display model. For
QPJ models, the maximum is 512 alarms, consisting of two files of 256 alarms.
For QPI models, the maximum is 768 alarms, consisting of three files of 256
alarms. When you first create an alarm, the first file of 256 is allocated. When
you exceed 256, the next file is opened.

The Alarms Window
The alarms window is used to create and edit alarm files and configure the alarm
message and buffers. To configure alarms, select the alarms button or alarms
from the components menu on the Panel Manager. This opens the alarms win-
dow and the New Bit Alarms dialog box. The alarms window appears on the
next page.

The large buttons at the bottom of the window allow rapid access to menu
selections. Config displays Alarm Configuration dialog box, Close exits the
Alarm window,  Add adds a new alarm, and Delete deletes an alarm.
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Bit and Word Address Tags
The alarm manager is the control center for alarm operations. The default setting
for the window is Bit Alarms. See Creating an Alarm Table in this chapter for
more information. When you first create an alarm table, you select a starting
address and then enter the number of consecutive bits or values. The alarm table
is built automatically. You can create a word alarm file by selecting New-Word
from the File menu. Word alarms are based on the value of a register.

Alarm Window Basics
Once you have opened the Alarm Window, you can perform basic editing
operations, such as saving or exporting an alarm file from the File Menu.

• Open: Opens an existing alarm file.

• Save: Saves the current alarm file with all the option settings. You must
have saved an alarm file for alarms to work.

• Save As: Saves the current alarm file using the specified file name.

• Delete: Deletes an existing alarm file. Once you delete the file, it cannot be
recovered.

• Import: Imports an existing alarm file. Alarm files have the file extension
*.alm. After you import the file, use Open to view the alarm table.

• Export: Exports the current alarm file using the *.alm file extension. When
using the export file feature, all alarm files are included in the export file.
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Congfiguring Alarms
When you create alarm messages, you determine both the format of the alarm
message on the Quick Panel display and the format of the message in the alarm
queue. The configuration options determine how the alarm message is displayed
in the alarm window as well as specifying what information appears in the alarm
queue.

Formatting Alarm Messages
The Alarm Configuration dialog box is used to format the alarm message by
indicating the starting column number of each portion of the alarm message.

The size of the alarm message depends on the Quick Panel display you are
using. For example, the Quick Panel Jr. Color display can show 49 5x7 charac-
ters in one line of the alarm window. The alarm message, date stamp and time
stamps must fit in the forty-nine character space. The following drawing shows
how a forty-nine character alarm window message is formatted using the default
settings.

Trigger Date Stamp Column
Trigger Time Stamp Column

Message Column

Acknowledge Time Stamp Column
Clear Time Stamp Column

1 10 16 37 44

10/ 12/ 95.13:00.Alarm.Text..........13:02..13:05.

Setting Up System Queues
The system queues are internal storage buffers for alarm messages. The queues
hold the active, historic and logged alarm messages and make them available to
the alarm window. The default size of each queue is ten messages. From the
Alarm Queue Settings dialog box you select the length of the system alarm
queues. If you do not need one or more of the alarm types, you can uncheck the
boxes next to the queue name. When the number of messages exceeds the size of
the buffer, the oldest message is deleted.
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When an alarm occurs, the message appears in the alarm window. When the
operator touches the display, the alarm management page appears. In addition to
specify the length of the alarm queues, by using the setup option on the Alarm
Queue Configuration dialog box you can select the colors and size of the text
displayed on the alarm management page.

The buttons on the bottom of the alarm management page are activated by
pressing the MODE button. Pressing the MODE button also displays the two
horizontal lines that are used as a cursor. The DONE button is always active.

A C T IV E   A L A R M S
0 9 /1 9 / 9 9  1 3 :2 8  A L A R M  T E X T  M E S S A G E  # 1
0 9 /1 9 / 9 9  1 3 :4 0  A L A R M  T E X T  M E S S A G E  # 2

D O N EA c k
A l lD e lA c kD o w nU p M O D ED e l

A l l

A 7A 4A 3A 2A 1A 0 A 6A 5

CAUTION: Press the MODE button once. Do not press it a second time. Pressing MODE a second
time causes the panel to freeze. Press DONE to exit.

Once the buttons are activated, they can be used to view and modify the contents
of the alarm queue. The Up and Down buttons move the cursor. Remember that
the alarm management page may only show a portion of the messages in the
queue. The Up and Down buttons allow scrolling the alarm queue messages to
the alarm page. Move the cursor to a message line and use the Ack button to
Acknowledge the alarm, or use the Del button to delete the message. Use Ack
All to Acknowledge all messages or Del All to delete all messages in the associ-
ated queue. Return to the panel where the alarm window is located by pressing
the DONE button.

You can also use the Ack, Ack All, Del, and Del All buttons on the bottom of the
alarm management page set a flag or write a value to a register in the controller,
so the controller is notified when an operator acknowledges or erases an alarm.
You specify the flags and registers in the Advanced Alarm Settings dialog box.
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Setting Up Initial Alarm States and Notification Tags
When configuring an alarm, you can also specify the initial condition of the
alarm processor and notification tags that tell the controller when an alarm has
been acknowledged or erased. To access the Advanced Alarm Settings dialog
box select the Advanced button on the Alarm Configuration dialog box.

Setting Up the Initial State
When the power is turned on, the alarm processor does not know the state of the
alarm bits or words. By assuming an initial state, the alarm processor can deal
with the alarm states until the true states are read from the controller. The default
setting is Same, which assumes no alarm transitions have occurred.

• Opposite: Assume an alarm transition has occurred.

• Same: Assume no alarm transition has occurred.

• False: Test for true alarm state and process the alarm if true. No action if
false.

• True: Test for false alarm state and process the alarm if false. No action if
true.

Setting Up Notification Tags
From the Advanced Alarm Settings dialog box, you can also use set up the Ack,
Ack All, Del and Del All buttons on the bottom of the alarm management page
to set a flag in your controller. Setting the flag can notify the controller when an
alarm is acknowledged or erased. To activate the buttons, assign a flag tag
variable to the button function.

The notification tag buttons are as follows:

• Ack: Individual Acknowledge
• Ack All: Global Acknowledge
• Del: Individual Erase
• Del All: Global Erase

You assign a notification tag the same way you assign other tags. For example, if
you assign Individual Acknowledge (Ack) to flag 20, the flag is set when the a
technical presses the Ack button and cleared when the button is released.

You can also deactivate the buttons on the bottom of the alarm management page
by selecting the associated Button Off checkbox on the Advanced Alarm Set-
tings dialog box.

Congfiguring Alarms
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Setting Up Bit Alarms
To create a new bit alarm file:

1. Select Alarms from the Components menu or select the Alarms button.

The New Bit Alarms dialog box appears.

4. Enter the Bit address (register), the number of bits, and the default state of
the alarms and select OK.

Quick Manager creates the alarm table.

Setting Up Word Alarms
To create a new alarm file:

1. Select Alarms from the Components menu or select the Alarms button.

2. When the New Bit Alarms dialog box appears, select Cancel.

3. To display the New Word Alarms dialog box, select New then Word from
the File menu.

The New Word Alarms dialog box appears.
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Creating an Alarm Table and Configuring Alarms

4. Enter the Word address (register), the number of words, and the starting and
ending values for the alarms and select OK.

Quick Manager creates the alarm table.

Selecting Configuration Options
The next step is to select the configuration options determine how the alarm
message is displayed in the alarm window.

To configure an alarm message:

1. Select Configuration from the File menu or select the Config button.

The Alarm Configuration dialog box appears.

NOTE: Control Tech recommends that you leave the Date format selection as mm/dd/yy. Leave the
Time format set to 24:00. See appendix C, Date Stamp System Variable and Chapter 6, Creat-
ing a Clock Display for information on setting the system date and time.

2. Specify the starting column number for each portion of the alarm message.

QD_178
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3. Select the Queue... button to display the Alarm Queue Configuration
dialog box.

4. Specify the size for the Active, Historic and Logged Alarm queues.

5. To choose appearance of the text on the alarm management page, select the
setup button.

The Alarm Queue Settings dialog box appears.

6. Select the text color and size and the background color for the alarm trig-
gered text, the alarm acknowledged text and alarm cleared text.

7. Select OK to return to the Alarm Queue Configuration dialog box. You
can specify the appearance of text for all three alarm queues.

8. When you are finished specifying the alarm queue configuration, select OK
to return to the Alarm Configuration dialog box.

9. Select the Advanced... button to display the Advanced Alarm Settings
dialog box.
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10. Select Opposite, Same, False or True for initial state of the alarms when
the Quick Panel is turned on. The default selection is Same and is the
correct setting for most applications.

11. Specify the tags used as notification tags for the Individual Acknowledge,
Global Acknowledge, Individual Erase and Global Erase.

12. If you want to deactivate any of the buttons on the alarm management page,
select the appropriate Button Off box.

13. Select OK to return to the Alarm Configuration dialog box.

14. Select OK to save the alarm configuration you have set up and return to the
Alarms Window.

15. At this point, you can either enter the text for your alarm messages or exit
the Alarms Window and create the alarm messages later.

15. When you are ready to exit the Alarms Window, select the Close button to
return to the Quick Manager Window. If you have not saved your alarm
file, Quick Manger asks if you want to save the file.

Entering Alarm Messages
Once you have determined the configuration of an alarm table, you can enter
alarm messages in it.

1. Select the message field with the mouse pointer.

2. Type the alarm message and press Enter.

The message area will appear as shown below. The next time you open the
Alarms window, the value field will reappear.
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Using Alarms in a Quickstep Program
To use the alarms, you need to add some instructions to your Quickstep program.
In the following example, when the error for servo 1 is greater than 1000, the
program stops the servo and stores 1 the alarm register in the controller. Storing
1 to register 250, displays an alarm message on the Quick Panel screen.

[245] CHECK_SERVO_1_ERROR
    ;;; This step monitors the error value for
    ;;; servo 1. If the error is greater than 1000,
    ;;; The program goes to task which stops the
    ;;; servo and sets the alarm register.
        ;;;
    ——————————————————————————————
    <NO CHANGE IN DIGITAL OUTPUTS>
    ——————————————————————————————
    if Servo1Error_R14101 >= 1000 goto SET_ALARM
    goto CHECK_SERVO_1_ERROR

[246] SET_ALARM
    ;;;
    ——————————————————————————————
    <NO CHANGE IN DIGITAL OUTPUTS>
    ——————————————————————————————
    stop (hard) Servo_1
    store 1 to Alarm_register_R250
    goto Next

Your alarm table can be set up to display a different alarm depending on the
value in a register. For example, you could set the alarm table up as follows:

Value in register Alarm message

1 Servo 1 stopped error over 1000

2 Servo 2 stopped error over 1250

3 Check pressure gauge 1
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Creating an Alarm Message Window
The alarm message window displays the formatted alarm message on a panel.
You use the Panel editor to create a panel with an alarm window. When you are
creating a message display, you must set the queue to active for the panel to
display new alarm messages. As new messages are triggered, they scroll into
the alarm window either from the top or the bottom. The default setting is
Scroll Up and shows the latest alarm message on the bottom of the alarm
message window. When the scroll direction is Scroll Down, the latest alarm
message appears at the top of the alarm message window.

To create an alarm window:

1. Select the alarm button icon on the Tools menu.

2. Move the cross hair to the position where you want the alarm message
button to appear and click the mouse.

The Quick Designer creates the alarm button and displays the Alarm
Window Settings dialog box.

3. Click one of the Queue radio buttons to select the alarm queue.

4. Select Scroll Up or Scroll Down.

5. Select Bezel... to display the Bezel Settings dialog box.

6. Change the Bezel, Outline, and/or Touch Color(s) if necessary; select
Flashing if desired.

7. Select the Simulate button to check your changes.

8. Select OK to save your changes and return to the Alarm Window Settings
dialog box or select Cancel to exit without saving your changes.

Creating and Testing Alarm Message Window
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9. Select Legend... to display the Legend Plate Settings dialog box.

10. Enter the Text for the push button and change the Text Size if necessary.

11. Change the Text, Background, and/or Outline Color(s) if necessary; select
Flashing if desired.

12. Select OK to save your changes and return to the Alarm Window Settings
dialog box or select Cancel to exit without saving your changes.

13. Select Text... to display the Text Settings dialog box.

14. Change the text and background color for the triggered, acknowledged and
cleared messages if necessary.

15. Change the Text Size if necessary.

16. Select OK to save your changes and return to the Alarm Window Settings
dialog box or select Cancel to exit without saving your changes.

17. Select OK to save your changes and return to the Alarm Window Settings
dialog box or select Cancel to exit without saving your changes.

If you decide that you want to have all alarm message window buttons
appear the same, select Make Default on the Alarm Window Settings
dialog box to save the current settings. The next alarm window you create
automatically uses the saved settings.
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Creating and Testing an Alarm Message Window

18. Until you resize it, the alarm message window on your panel is too small to
read. Select the alarm message window with the mouse and use the sizing
handles to enlarge the window over four cells.

19. Repeat steps 1 - 18 to create alarm message windows for the historic and
logged alarm queues

Checking and Testing an Alarm Panel
To see what your alarm panel looks like, download the panel to your Quick
Panel display. When the download is complete, select the alarm panel.

1. Using the CTC Monitor program, enter a value in your alarm register on
your controller that will display an alarm message.

2. When the alarm message appears, touch the window to bring up the alarm
manager page and the Active Alarm queue.

ACTIVE  ALARMS
09/19/99 13:28 ALARM TEXT MESSAGE #1
09/19/99 13:40 ALARM TEXT MESSAGE #2

DONEAck
AllDelAckDownUp MODEDel

All

A7A4A3A2A1A0 A6A5

NOTE: The alarm manager page looks different when you use a keypad. See Chapter 7, Keypads, for
additional information.

3. To activate the small buttons on the bottom of the panel, touch the MODE
button. The DONE button is always active.

CAUTION: Do NOT press the MODE button more than once. If you do, the panel will freeze and no
further operations will be displayed. Press DONE to exit.

4. To test the acknowledge button, press it. The acknowledge time stamp
should appear.

5. You can delete individual or all of the alarms in the queue by using the Del
or Del All buttons.

6. Use the Up and Down keys to move the cursor to different alarms.

7. Press the DONE button to return to the alarm panel.

8. The alarm window should show that the alarm has been acknowledged. If
you cleared or deleted the alarm, the Active Alarm window does not show
the alarm. Cleared or deleted alarm message are stored in the Historic and
Logged alarm queues.
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Using the Polyline Tool
The polyline tool is used to draw single line segments, multiple line segments,
and filled/unfilled polygons.

Creating a Polyline Drawing
1. Select the polyline icon on the Tools menu.

2. To create a line segment, move the cross hair to the point where you want to
begin drawing a line.

3. Click and HOLD the left mouse button.

4. Move the mouse so that the cross hair is now at the second point of the line.

5. Release the left mouse button to complete the line. A small box appears on
each end of the line. This small box is called a node.

The polyline tool is still active and you can continue to draw additional line
segments or add segments to existing lines. You can add segments to existing
lines only when the nodes are visible. To add additional segments to the line
shown above, move the cross hair over a node, click and hold the left mouse
button, move the cursor to a new point and release the mouse button.

6. You can continue to add line segments to create a polygon. A true polygon is
a closed figure bounded by three or more sides.

The last leg of a polygon must connect to the node of the first leg so that the
figure is closed. The drawing shows the sequence of adding segments to
create a filled polygon.

7. To exit the polyline drawing mode, click on the pointer tool.

NOTE: When creating a polygon, be careful drawing when the grid is set to snap. The cursor will
attempt to snap to the nearest grid point on the drawing grid. The mouse cursor may be in a
different location when you start to create the next line. This causes problems if you attempt to
make a polygon. Make sure you draw lines from grid point to grid point, or turn off the snap to
grid feature.

Moving a Polyline Object
1. To move a polyline object, point to the object, then click and hold the left

mouse button. The object nodes will appear.

2. Move the object to a new location and release the mouse button. This
method of moving polyline objects is the same for all objects. You can also
move an object when the sizing handles are visible by moving the cursor
inside the object so that crossed arrows appear. Click and hold the left
mouse button, then move the object to a new location and release the mouse
button.
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Editing Nodes
1. When you click on a polyline object, the object nodes will appear. To move

a node, move the cross hair over a node, then click and hold the left mouse
button.

2. Move the node to a new location and release the mouse button.

3. To display the node edit menu, move the cross hair over a node, then and
click and hold the RIGHT mouse button.

4. Click a menu item to execute the function.

– Insert mode adds a node between the current node and the next node in
a counter clockwise direction.

– Append mode adds a node between the current node and the next node
in a clockwise direction.

– Delete mode removes the selected node.

– Open polygon removes the line segment between the current node and
the next node in a clockwise direction. Removing a segment from a
polygon converts it to a polyline. This menu option appears when you
select a polygon and changes to Close polygon when you are working
with a polyline.

– Close polygon adds a line segment between the ends of a continuous
polyline to form a polygon.  This menu option appears when you select a
polyline and changes to Open polygon when you are working with a
polygon.

– About Tool displays the copyright information for the polyline tool.

Sizing a Polyline Object
1. To select the entire object for sizing, click on the object to select it

2. Click on it again to change from the editing mode to the sizing mode.

The sizing handles appear around the object. If you click too fast, you will
get the Line/Polyline/Polygon Settings dialog box.

3. To size an object, select one of the sizing handles and observe the pointer
changes into a double end arrow.
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Using the Polyline Tool

4. Press and hold the left mouse button and adjust the size.

Sizing handles on the corners are for diagonal sizing. Handles between the
corners are for horizontal and vertical sizing. The drawing shows an object
resized in the horizontal direction.

Polyline Settings
The Line/Polyline/Polygon Settings dialog box allows you to change the
polygon. To display the settings dialog, double click on the polyline object. If
you double click too slow, you will only display the sizing handles.

• Line Style: Solid, dashed, dotted, dash-dot, dash-dot-dot, none.

• Filled/Unfilled: Check the Filled box to fill the polygon with color.

• Line Color: Select the color of the polyline and polygon outline.

• Fill Color: Select the color for the inside of the polygon.

• Make Default: If you decide that you want to have all line, polyline, and
polygon objects appear the same way, select Make Default button on the
Line/Polyline/Polygon Settings dialog box to save the current settings. The
next line, polyline, and polygon you create automatically uses the saved
settings.
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Using the Text Tool
The text tool is used to add text to a panel.

1. Select the text icon on the tool bar.

2. To add text, move the cross hair cursor to the desired cell and click the left
mouse button.

The Text Settings dialog box appears.

3. Type the text you want in the Text box.

4. Specify the Text Size and/or Color if necessary; select Flashing if desired.

5. Select OK to save the settings and close the dialog box or select Cancel to
exit without saving your changes.

If you decide that you want to have all text appear the same way, select
Make Default button on the Text Settings dialog box to save the current
settings. The next text you enter automatically uses the saved settings.

NOTES:
1. The Text Settings dialog box can also be displayed by double clicking a

circle.
2. Text characters cannot be sized like other objects.

Moving Text
1. Place the cursor over the text, click and hold the left mouse button

2. Move the text to the desired location.

Text snaps to grid positions like other objects. For fine placement of text,
turn of the tiling snap to grid option.
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The bitmap tool is used to place a bitmap image on a panel. The bitmap can be
created using Windows™ Paintbrush or imported from another bitmap source.
The bitmap becomes a static image on the panel. The statistics for each bitmap
are presented in the Bitmap Settings dialog box. The statistics include the
width, height, colors, and size. Quick Designer supports monochrome or 16
color bitmaps. Each object on a panel requires a small amount of memory. The
panel can contain any combination of panel objects. Bitmaps that take a lot of
memory will limit the number of objects you can place on a panel.

You can import a bitmap image from any program that generates bitmap images.
These sources include paint, icon editors, and capture programs. You can import
bitmap images from any directory or drive. You can also export a bitmap image
from a panel to any directory or drive.

Bitmap Size
Before you attempt to place a bitmap on a panel, use the following approxima-
tions to determine the size of the bitmap.

• Monochrome Bitmap: (Width / 8) x Height

Example: 80 x 80 mono bitmap = (80 / 8) x 80 = 800 bytes.

• 16 Color Bitmap: (Width / 2) x Height

Example: 80 x 80 16 color bitmap = (80 / 2) x 80 = 3200 bytes.

To determine the size of your bitmap use one of the following methods:

• Open Paintbrush and select View/Cursor Position. Move the cursor to the
corner of the bitmap and note the coordinates, for example, 80, 80. Use the
equations above to calculate the approximate size of the bitmap.

• To determine the actual image size of a bit map, load the file into Paintbrush
and select the File /Save As option.  Select the Info... button. It will display
the width and height of the bit map.

The disadvantage to using bitmap pictures in your Quick Panel application is
that they may require a lot of memory.  As the number and size of bitmap
graphics increase in your application, the amount of memory left for other
objects quickly disappears. The amount of memory that a bitmap requires is
dependent on its size and type. For example, a monochrome bitmap will require
1/4 the memory of the same sized 16 color bitmap. Another disadvantage is that
the draw time of the panel increases.

Creating a bitmap:
1. Select the bitmap icon on the tool bar.

2. Move the cross hair to the cell where you want the bitmap to appear and
click the mouse.

Quick Designer creates an empty bitmap frame and displays the Bitmap
Settings dialog box.

Using the Bitmap Tool
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3. The initial size of the bitmap is one cell. When the Bitmap Settings dialog
box appears, select the Cancel button.

4. Size the bitmap object to the estimated final size for the panel.

5. Double click on the bitmap to reopen the Bitmap Settings dialog box.

The selections on the Bitmap Settings dialog box allow you to determine
how the bitmap is placed in the empty frame. The default settings place the
bitmap at the top, left corner of the frame. Selecting the Stretch fit option
automatically sizes the bitmap to the empty frame.

6. Select Import... to import a bitmap from another source.

NOTE: Edit... does not work in Windows 95, Windows  98 or Windows NT.

7. To stretch the bitmap to fit the frame size, click the Stretch fit check box.

The screen size is 320 x 240 for five inch displays and 640 x 400 for nine
inch displays. Bitmaps that exceed the screen size can be displayed by
clicking the Stretch fit check box.

8. Specify the Horizontal Justify and/or Vertical Justify if necessary.

9. Select OK to save the bitmap and close the dialog box or select Cancel to
exit without saving your changes.

If you decide that you want to have all bitmaps appear the same way, you can
click the Make Default button in the Bitmap Settings dialog box. The
current settings in the Bitmap Settings dialog box will be saved. The next
time you create a bitmap, the saved settings are automatically applied.
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Using the Circle Tool
The circle tool is used to draw filled or unfilled circles. You can select the line
style, line color, and the circle fill color. The line style can be solid, dashed,
dotted, dash-dot, dash-dot-dot, and none.

To create a circle:

1. Select the circle icon on the Tools menu.

2. Move the cross hair cursor to the desired cells and click the left mouse
button.

Quick Designer creates an circle and displays the Circle Settings dialog box.

3. Specify the line style and color, filled or unfilled circles, and the circle fill
color, if necessary; select flashing if desired.

4. Select OK to save the circle and close the dialog box or select Cancel to
exit without saving your changes.

If you decide that you want to have all circles appear the same way, you can
click the Make Default button in the Circle Settings dialog box. The current
settings in the Circle Settings dialog box will be saved. The next time you
create a circle, the saved settings are automatically applied.

Moving a Circle
To move a circle:

1. Place the cursor over the object, click and hold the left mouse button

2. Move the object to the desired location and release the mouse button.

Sizing a Circle
Once you have created a circle you can change its size by selecting it and using
the sizing handles.

To select a circle for sizing:

1. Select the circle using the mouse.

Sizing handles appear on the corners.

QT_16
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2. To size an object, move the cursor over one of the sizing handles.

The pointer changes into a double end arrow.

3. Click and hold the left mouse button and adjust the size.
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Using the Rectangle Tool
The rectangle tool is used to draw filled or unfilled rectangles. You can select
the line style, line color, and the rectangle fill color. The line style can be solid,
dashed, dotted, dash-dot, dash-dot-dot, and none.

To create a rectangle:

1. Select the rectangle icon on the Tools menu.

2. Move the cross hair cursor to the desired cells and click the left mouse
button.

Quick Designer creates an rectangle and displays the Rectangle Settings
dialog box.

3. Specify the line style and color, filled or unfilled rectangles, and the rect-
angle fill color, if necessary; select flashing if desired.

4. Select OK to save the rectangle and close the dialog box or select Cancel to
exit without saving your changes.

If you decide that you want to have all rectangles appear the same way, you
can click the Make Default button in the Rectangle Settings dialog box.
The current settings in the Rectangle Settings dialog box will be saved. The
next time you create a rectangle, the saved settings are automatically applied.

Moving a Rectangle
To move a rectangle:

1. Place the cursor over the object, click and hold the left mouse button

2. Move the object to the desired location and release the mouse button.

Sizing a Rectangle
Once you have created a rectangle you can change its size by selecting it and
using the sizing handles.

To select a rectangle for sizing:

1. Select the rectangle using the mouse.

Sizing handles appear on the corners.
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2. To size an object, move the cursor over one of the sizing handles.

The pointer changes into a double end arrow.

3. Click and hold the left mouse button and adjust the size.

QD_141





Creating Panel Objects
Contents

Creating an Illuminated Push Button 6-2
Creating a Push Button 6-5
Creating a Numeric Data Display 6-8
Creating a Numeric Data Entry Button 6-10
Creating a Goto Panel Push Button 6-13
Creating a Selector Switch 6-15
Creating a Word Button 6-18
Creating a Pilot Light 6-21
Creating a Local Message Display 6-25
Creating a Local Image Display 6-29
Creating a Clock Display 6-32
Creating a Bar Graph 6-34
Creating a Trend Display 6-38
Creating a Analog Meter Display 6-42
Creating a Print Button 6-45
Creating a Video Display 6-48

Chapter 6



6-2 Quick Designer User Guide

Control Technology Corporation proprietary, Reproduction or distribution forbidden.

Creating an Illuminated Push Button
An illuminated push button consists of a bezel, an OFF lens, and an ON lens.
The illuminated push button requires two controller variables; one for the lens
(pilot light) and one for the push button.

When creating an illuminated push button you specify the following items:

• Push Button Tag Variable: You assign tag variable name to the push
button. The tag is a flag on a register in the controller that the Quick Panel
can control, by setting or clearing the flag or by storing a 1 or 0 in the
register.

• Action: The push button action can be selected as momentary, on, off, or
toggle.

— Momentary, where the flag or register is turned on when the push
button is pressed and turned off when the push button is released.

— On turns the flag or register on when the push button is pressed and no
action is taken when the push button is released.

— Off turns the flag or register off when the push button is pressed and no
action is taken when the push button is released.

— Toggle changes the state of the flag or register to the opposite state when
the push button is pressed and no action is taken when the push button is
released.

• Lens Tag Variable: You must also assign a tag variable name to the lens
(pilot light). The tag should be a flag or register in the controller that the
Quick Panel can read. The state of the flag (set or clear) determines whether
the on or off state is displayed. This is usually the same flag assigned to the
push button tag variable.

• Bezel: The Bezel portion of the push button is used to give a visual indica-
tion to the operator that the button was pressed. The bezel, outline, and
touch color can be modified to enhance the visual impact of the push button.
When the push button is not pressed the bezel color is displayed, but when
the push button is pressed the touch color will be displayed. The outline
color remains constant whether the push button is pressed or not pressed.
The default settings are: bezel color = white,  outline color = black, touch
color = white.

• State: An illuminated push button has two states, on and off. You can change
the text and appearance of each state.

To create an illuminated  push button:

1. Select the push button icon on the Tools menu.

2. Move the cross hair to the position where you want the illuminated push
button to appear and click the mouse.
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The Quick Designer creates the illuminated push button and displays the
Illuminated Push Button Settings dialog box.

3. Enter F and the number of the flag or R and the number of a register in the
Button Tag and Light Tag fields.

4. Specify an Action; select one of the following:

• Momentary
• ON
• OFF
• Toggle

5. Select Bezel... to display the Bezel Settings dialog box.

6. Change the Bezel, Outline, and/or Touch Color(s) if necessary; select
Flashing if desired.

7. Select the Simulate button to check your changes.

8. Select OK to save your changes and return to the Illuminated Push Button
Settings dialog box or select Cancel to exit without saving your changes.

9. Select States... to display the State Settings dialog box.

10. Enter the text for the state and change the Text Size if necessary
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Creating an Illuminated Push Button

11. Change the Text, Lens, and/or Outline Color(s) if necessary; select Flash-
ing if desired.

12. Select Next to display the next state options.

13. Enter the text for the for the 1 state.

14. Change the Text Size if necessary

15. Change the Text, Lens, and/or Outline Color(s) if necessary; select Flash-
ing if desired.

16. If desired, select Previous or Next to return to the other state settings;
continuously selecting Previous or Next allows you to toggle between
states.

17. Select OK to save your changes and return to the Push Button Settings
dialog box or select Cancel to exit without saving your changes.

If you decide that you want to have all illuminated push buttons appear the
same, select Make Default on the Illuminated Push Button Settings dialog
box to save the current settings. The next illuminated push button you create
automatically uses the saved settings.

18. Select OK to save the push button settings and close the dialog box.
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Creating a Push Button
A push button consists of a bezel and a legend plate. Pressing a push button sets
or clears (1 or 0) a flag or a register. The bezel changes color to indicate the
button has been pressed.

When creating an illuminated push button you specify the following items:

• Push Button Tag Variable: You assign tag name to the push button. The tag
is a flag or register in the controller that the Quick Panel can control.

• Action:  The push button action can be selected as momentary, on, off, or
toggle.

— Momentary, where the flag or register is turned on when the push
button is pressed and turned off when the push button is released.

— On turns the flag or register on when the push button is pressed and no
action is taken when the push button is released.

— Off turns the flag or register off when the push button is pressed and no
action is taken when the push button is released.

— Toggle changes the state of the flag or register to the opposite state when
the push button is pressed and no action is taken when the push button is
released.

• Bezel:  The Bezel portion of the push button is used to give a visual indica-
tion to the operator that the button was pressed. The bezel, outline, and
touch color can be modified to enhance the visual impact of the push button.
When the push button is not pressed the bezel color is displayed, but when
the push button is pressed the touch color will be displayed. The outline
color remains constant whether the push button is pressed or not pressed.
The default settings are: bezel color = white,  outline color = black, touch
color = white.

• Legend:  The legend plate allows you to provide text information to the
operator on the action that will occur when the push button is pressed . This
text is constant and will not change when the push button is pressed. The
text size can be changed , and the text will automatically center itself both
vertically and horizontally. The text color, background color, and outline
color can be modified in appearance to enhance the application. The default
settings are: text color = white, background color = black and outline color =
white.

To create a push button:

1. Select the push button icon on the Tools menu.

2. Move the cross hair to the position where you want the push button to
appear and click the mouse.

The Quick Designer creates the push button and displays the Push Button
Settings dialog box.

QT_19

QD_87



6-6 Quick Designer User Guide

Control Technology Corporation proprietary, Reproduction or distribution forbidden.

Creating a Push Button

3. Enter F and the number of the flag or R and the number of a register in the
Tag field.

4. Choose the Style of the push button using the select button; the styles are
Standard, Circular and Simple. Standard (selected for this example) is shown
on the preceding page. Circular and simple push buttons are shown below.

5. Specify an Action.

6. Select Bezel... to display the Bezel Settings dialog box.

7. Change the Bezel, Outline, and/or Touch Color(s) if necessary; select
Flashing if desired.

8. Select the Simulate button to check your changes.

9. Select OK to save your changes and return to the Push Button Settings
dialog box or select Cancel to exit without saving your changes.

10. Select Legend... to display the Legend Plate Settings dialog box.

11. Enter the Text for the push button and change the Text Size if necessary

12. Change the Text, Background, and/or Outline Color(s) if necessary; select
Flashing if desired.
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13. Select OK to save your changes and return to the Push Button Settings
dialog box or select Cancel to exit without saving your changes.

If you decide that you want to have all push buttons appear the same way,
you select Make Default on the Push Button Settings dialog box to save
the current settings. The next push button you create automatically uses the
saved settings.

14. Select OK to save the push button settings and close the dialog box.
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Creating a Numeric Data Display
A numeric data display consists of a numeric readout and a legend plate. The
data display requires a tag variable for the numeric data.

When creating a data display, you specify the following items:

• Tag Variable: A tag variable is a numeric register and must be assigned to
the numeric Data Display. The Quick Panel reads the value in the register.

• Legend Plate: The legend plate allows you to provide text information to
the operator about the meaning of the current value being displayed. The
text size can be changed , and the text automatically centers itself both
vertically and horizontally. The text color, background color, and outline
color can be modified. The default settings are: text color = white, back-
ground color = black and outline color = white.

• Data Format Settings: The data format window allows setting up the
display information. The data size selected determines the maximum number
of digits available for viewing. The number of digits displayed can be
selected and is equal to, or less than, the maximum allowed because of the
text size selected. The display can show a +/- sign. A decimal point can be
displayed, and it uses one of the digit positions. The data can be displayed in
a variety of formats including decimal, binary, hexadecimal, octal, and
floating point. The data color and background can be modified to enhance
the appearance.

The default text size is set to 7 x 9, justification is set to Right, Decimal
format, 4 digits and 0 decimal places.

To create a numeric display:

1. Select the Numeric Display icon on the Tools menu.

2. Move the cross hair to the position where you want the numeric display to
appear and click the mouse.

The Quick Designer creates the numeric display button and displays the
Numeric Data Display Settings dialog box.

3. Enter  R and the number of a numeric register in the Tag field.
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4. Select Legend... to display the Legend Plate Settings dialog box.

5. Enter the Text for the numeric data display.

6. Change the Text Size if necessary

7. Change the Text, Background, and/or Outline Color(s) if necessary; select
Flashing if desired.

8. Select OK to save your changes and return to the Numeric Data Display
Settings dialog box or select Cancel to exit without saving your changes.

9. Select Data Format... to display the Data Format Settings dialog box.

10. Change the Text Size if necessary.

11. Change the Justification of the data if necessary.

12. Select the Signed Number field if necessary.

13. Specify the Format of the data and the number of Digits

14. Specify the Decimal Position if necessary.

15. Change Text and/or Background Color(s) if necessary; select Flashing if
desired.

16. Select OK to save your changes and return to the Numeric Data Display
Settings dialog box or select Cancel to exit without saving your changes.

If you decide that you want to have all numeric data displays appear the same
way, select Make Default button on the Numeric Data Display Settings
dialog box to save the current settings. The next numeric data display you
create automatically uses the saved settings.

17. Select OK to save the settings and close the dialog box.
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A numeric data entry button with data entry consists of a bezel, numeric readout
and a legend plate. The data entry also requires a variable that it will read and
display the current value. When the bezel is touched, the screen will display a
data entry panel.

When creating a numeric data entry, you specify the following items:

• Tag Variable: A tag variable name is a numeric register and must be as-
signed to the numeric data entry. The register must be one that the Quick
Panel display can both read and write to. This is the register the Quick Panel
sends new data to.

• Trigger Tag: Enter the tag name of a flag or register. The trigger tag tells the
controller when the operator is entering a new value in the register specified
in the tag variable field. You can program an instruction in your Quickstep
program that uses the setting and clearing of the flag or the value in the
register.

Using a flag: When the operator presses the ENTER key on the numeric data
entry panel, the Quick Panel sends the value 1 to the controller to set the flag.
When the operator releases the ENTER key, the Quick Panel sends the value
0 to the controller, which clears the flag.

Using a register: When the operator presses the ENTER key on the numeric
data entry panel, the Quick Panel sends the value 0000 0000 0001 to the
register. When the operator releases the ENTER key, the Quick Panel sends
the value 0000 0000 0000 to the register.

• Bezel: The Bezel portion of the numeric data entry is used to give a visual
indication to the operator that the button was pressed. The bezel, outline,
and touch color can be modified to enhance the visual impact of the numeric
data entry button. When the push button is not pressed the bezel color is
displayed, but when the push button is pressed the touch color is displayed.
The outline color remains constant whether the push button is pressed or not
pressed. The default settings are: bezel color = white,  outline color = black,
touch color = white. Press the Simulate button to observe the action of the
bezel color change.

• Legend Plate: The legend plate allows you to provide text information to
the operator about the meaning of the current value being displayed.  The
text size can be changed , and the text automatically centers itself both
vertically and horizontally. The text color, background color, and outline
color can be modified in appearance to enhance the application. The default
settings are: text color, white, background color, black and outline color,
white.

• Data Format Settings: The data format window allows you to customize
the display information for your application. The data size selected deter-
mines the maximum number of digits available for viewing. You can specify
the number of digits displayed. The number of digits displayed can be equal
to, or less than, the maximum allowed, depending on the text size selected.
The maximum number of digits for Hex is eight, and the maximum number
of digits for all other data displays is nine. The display can show a +/- sign,
which uses one of the digit positions. A decimal point can be displayed and
uses one of the digit positions. The data can be displayed in a variety of
formats including decimal, binary, hexadecimal, octal, and floating point.
The data color and background can be modified to enhance the appearance.

Creating a Numeric Data Entry Button
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The default text size is set to 7 x 9, justification is set to Right, data format is
decimal using 4 digits and 0 decimal places.

• Input Range: The input range establishes the minimum and maximum
values that the operator is allowed to enter and send to the tag variable.

• Data Entry Screen: When the numeric data entry push button is pressed,
the Quick Panel displays a data entry panel. The current variable value is
displayed in the center area. The minimum and maximum entry values are
displayed. Press the numeric keys to enter a new value. Press the enter key
to send the data to the controller. If the data is out of range, no data  is sent
and a warning message appears. The INC or DEC arrows are used to incre-
ment or decrement the current value. The new value is sent to the controller
when the arrow is released. Press the done button to return to the panel
display.

To create a data entry display:

1. Select the numeric data entry icon on the Tools menu.

2. Move the cross hair to the position where you want the numeric display to
appear and click the mouse.

The Quick Designer creates the numeric display button and displays the
Numeric Data Entry Settings dialog box.

3. Enter R and the number of a register in the Tag field and enter R or F and
the number of a flag or register in the Trigger Tag field.

4. Specify the Minimum and Maximum values for the Input Range.

5.  Select Bezel... to display the Bezel Settings dialog box.

6. Change the Bezel, Outline, and/or Touch Color(s) if necessary, select
Flashing if desired and click the Simulate button to check your changes.

Creating a Numeric Data Entry Button
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Creating a Numeric Data Entry Button
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7. Select OK to save your changes and return to the Numeric Data Entry
Settings dialog box or select Cancel to exit without saving your changes.

8. Select Legend... to display the Legend Plate Settings dialog box.

9. Enter the Text for the numeric data entry and change the Text Size if neces-
sary

10. Change the Text, Background, and/or Outline Color(s) if necessary; select
Flashing if desired.

11. Select OK to save your changes and return to the Numeric Data Entry
Settings dialog box or select Cancel to exit without saving your changes.

12. Select Data Format... to display the Data Format Settings dialog box.

13. Change the Text Size if necessary.

14. Change the Justification of the data if necessary.

15. Select the Signed Number field if necessary.

16. Specify the Format of the data, the number of Digits, and Decimal Position
if necessary.

17. Change Text and/or Background Color(s) if necessary; select Flashing if
desired.

18. Select OK to save your changes and return to the Numeric Data Entry
Settings dialog box or select Cancel to exit without saving your changes.

If you decide that you want to have all numeric data entry buttons appear the
same way, select Make Default button on the Numeric Data Entry Settings
dialog box to save the current settings. The next numeric data entry button
you create automatically uses the saved settings.

19. Select OK to save the data entry settings and close the dialog box.
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A goto panel push button consists of a panel name, bezel and a legend plate.
When the button is touched, the screen will change to display the designated
panel.

Creating a Goto panel button when the panel you intend to go to has not been
created yet, requires some planning. For example, if you are working on your
very first panel and you create a Goto push button to go to the next panel, you
need to enter a panel name in the Panel Name field. The name you pick must be
exactly the same as the panel you intend to go to. To go to the panel called
MAIN, you must enter the panel name as MAIN. You cannot use main in lower
case letters.

Modes of Operation
The goto panel button has two modes of operation, local mode and controller
mode. In the local mode, pressing the goto Panel button displays the designated
panel. No connection to a controller is required. In the controller mode, a
register is used to trigger the desired panel. The mode is determined by the
panel trigger tag option in the display device Configuration dialog box.

If the panel trigger tag is left blank, then the goto button works in the local
mode. When you press the goto button, the Quick Panel displays the selected
panel. You do not have to be connected to a controller for the goto button to
work properly.

Creating a Goto Button
To create a goto panel push button:

1. Select the goto panel push button icon on the Tools menu.

2. Move the cross hair to the position where you want the Goto panel push
button to appear and click the mouse.

The Quick Designer creates the goto panel push button and displays the
Goto Panel Button Settings dialog box.

3. Enter (type in) or select the  Panel Name for the panel to go to.

Creating a Goto Panel Push Button
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4. Select Bezel... to display the Bezel Settings dialog box.

5. Change the Bezel, Outline, and/or  Touch Color(s) if necessary; select
Flashing if desired.

6. Select the Simulate button to check your changes.

7. Select OK to save your changes and return to the Goto Panel Button
Settings dialog box or select Cancel to exit without saving your changes.

8. Select Legend... to display the Legend Plate Settings dialog box.

9. Enter the Text for the panel.

10. Change the Text Size if necessary

11. Change the Text, Background, and/or  Outline Color(s) if necessary; select
Flashing if desired.

12. Select OK to save your changes and return to the Goto Panel Button
Settings dialog box or select Cancel to exit without saving your changes.

If you decide that you want to have all goto buttons appear the same way,
select Make Default button on the Goto Panel Button Settings dialog box
to save the current settings. The next goto button you create automatically
uses the saved settings.

13. Select OK to save the Goto Panel push button settings and close the dialog
box.

Creating a Goto Panel Push Button
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A selector switch consists of a bezel, a legend plate and initially two off lenses
and two on lenses. The selector switch requires multiple variables, one for each
selector switch position. These variables are interlocked so that only one of them
can be turned on. Each time the selector switch is pressed the position that is
currently on is turned off and the next position is turned on. The number of
positions can be two, three, or four. The following drawing shows the three
options.

A Selector Switch includes a bezel and can have up to four positions with
associated legends.

To create a Selector Switch:

1. Select the selector switch icon on the Tools menu.

2. Move the cross hair to the position where you want the selector switch to
appear and click the mouse.

The Quick Designer creates the selector switch and displays the Selector
Switch Settings dialog box.

3. Specify the number of Positions for the switch.

4. Enter R and the number of a register in the Position 1 Tag field.

Creating a Selector Switch
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Creating a Selector Switch

QD_81

5. Select Position 1 States... to display the State Settings dialog box.

6. Enter the text for the  state.

7. Change the Text Size if necessary

8. Change the Text, Lens, and/or Outline Color(s) if necessary; select Flash-
ing if desired.

9. Select Next to display the options for the next state.

10. Enter the text for the next state.

11. Change the Text Size if necessary

12. Change the Text, Lens, and/or Outline Color(s) if necessary; select Flash-
ing if desired.

13. If desired, select Previous to return to the other state settings; continuously
selecting Previous allows you to toggle between states.

14. Select OK to save your changes and return to the Selector Switch Settings
dialog box or select Cancel to exit without saving your changes.

15. Select Next....

QUICK DESIGNER displays the Selector Switch Settings dialog box for
Position 2.

16. Enter R and the number of a register in the Position 2 Tag field.

17. Select Position 2 States... to display the State Settings dialog box.

18. Follow the instructions in steps 6 through 14 to specify the information of
Position 2.

If you have chosen more than two positions for your selector switch, Quick
Designer displays the Selector Switch Settings dialog box for each selector
switch position in turn.

19. Select Bezel... to display the Bezel Settings dialog box.
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20. Change the Bezel, Outline, and/or Touch Color(s) if necessary; select
Flashing if desired.

21. Select the Simulate button to check your changes.

22. Select OK to save your changes and return to the Selector Switch Settings
dialog box or select Cancel to exit without saving your changes.

23. Select Legend... to display the Legend Plate Settings dialog box.

24. Enter the Text for the panel.

25. Change the Text Size if necessary

26. Change the Text, Background, and/or  Outline Color(s) if necessary; select
Flashing if desired.

27. Select OK to save your changes and return to the Selector Switch Settings
dialog box or select Cancel to exit without saving your changes.

If you decide that you want to have all selector switches appear the same
way, select Make Default button on the Selector Switch Settings dialog box
to save the current settings. The next selector switch you create automatically
uses the saved settings.

28. Select OK to save the Selector Switch settings and close the dialog box.

QD_85



6-18 Quick Designer User Guide

Control Technology Corporation proprietary, Reproduction or distribution forbidden.

QT_22

Creating a Word Button
A word button is a multifunction object that performs Set, Add, Subtract, AND,
OR, XOR on a register or data table value.  For example, if the selected value is
5, then the word button can set a register to the value 5, or add 5 to a register, or
subtract 5 from a register. The logical functions of AND, OR and XOR can also
be performed using a value and a register or data table.

Selecting Button Style
When creating a word button you can specify three different styles as shown
below.

Setting Button Action
The Word Button Settings dialog box contains a pull-down list box that sets the
action to be performed on the register. The available action options are:

• Set: Sets the register value equal to the number in the Value field.

• Add: Adds the number in the Value field to the register value.

• Subtract: Subtracts the number in the Value field from the register value.

• AND: Performs a logical AND operation between the number in the Value
field and the register value.

• OR: Performs a logical OR operation between the number in the Value field
and the register value.

• XOR: Performs a logical XOR operation between the number in the Value
field and the register value.

Specifying Mode
The Word Button Settings dialog box contains a pull-down list box that selects
the number base for the Value field. The default setting is Decimal. The avail-
able options are

• Decimal
• Signed (not currently available)
• Octal
• Hex
• Binary

Creating a Word Button
To create a Word Button:

1. Select the Word Button icon on the Tools menu.
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2. Move the cross hair to the position where you want the plate  to appear and
click the mouse.

The Quick Designer creates the Word Button and displays the Word Button
Settings dialog box.

3. Enter R or D and the number of a register or data table row and column in
the Tag field.

4. Choose the Action to be performed using the Select button; this example
uses the default selection Set.

5. Choose the Style using the Select button; this example uses the default
selection Standard.

6. Choose the Mode to determine the number base for the value field using the
Select button.

7. Choose the number Value to be used in the mode of operation using the
Select button; this example uses the default selection 0.

8. Select Bezel... to display the Bezel Settings dialog box.

9. Change the Bezel, Outline, and/or  Touch Color(s) if necessary; select
Flashing if desired.

10. Select the Simulate button to check your changes.

11. Select OK to save your changes and return to the Word Button Settings
dialog box or select Cancel to exit without saving your changes.
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Creating a Word Button

12. Select Legend... to display the Legend Plate Settings dialog box.

13. Enter the Text for the panel.

14. Change the Text Size if necessary

15. Change the Text, Background, and/or  Outline Color(s) if necessary; select
Flashing if desired.

16. Select OK to save your changes and return to the Word Button Settings
dialog box or select Cancel to exit without saving your changes.

If you decide that you want to have all word buttons appear the same way,
select Make Default button on the Word Button dialog box to save the
current settings. The next message display you create automatically uses the
saved settings.

17. Select OK to save the Word Button settings and close the dialog box.

QD_85



Creating Panel Objects 6-21

Control Technology Corporation proprietary, Reproduction or distribution forbidden.

A pilot light is an indicator that shows the on or off condition of a variable. The
pilot light tool allows you to create a square (Standard) or circular pilot light.
The standard pilot light consists of two square lenses, each with its own color
and text options. Each lens can have a different text message.

The circular pilot light consists of two round lenses and a legend plate. The
legend plate contains a fixed text message.

The pilot light requires a register or flag variable that will be monitored to
determine when to display the off state and when to display the on state.

Pilot Light Style
Pilot lights can be either standard or circular style pilot light. If you select the
standard pilot light, the legend button is inactive (grayed out) and you cannot
assign it a legend. If you select the circular pilot light, you may assign it a
legend.

Standard Pilot Light
The elements of the standard pilot light are shown below. The standard pilot
light is a square lens with text inside. The lens has two states, either on or off.
You can select the lens color, outline color, text color and text size for each state.
If you load a color project into a monochrome unit, red, green and blue are
converted to black, and yellow, magenta, and cyan are converted to white.

Power
Feed
On

Lens color state 1

Lens outline

Lens color state 0

Text color
Power
Feed

Stalled

Standard Pilot Light States
A standard pilot light has two states, on and off. You can change the text size and
appearance of each state and choose how the justify the text. The last state
selected is the one displayed on the panel when you click the OK button. Each
state can display differently formatted text.

Circular Pilot Light
The elements of the circular pilot light are shown below. The circular pilot light
is a round lens and a legend plate. The lens has two states, either on or off. For
each state, you can select the lens color and the lens outline color. Although the
lens can change color, the legend plate and text remain constant. You can select
the legend plate text color and size, legend plate outline color and legend plate
background color. If you load a color project into a monochrome unit, red, green
and blue are converted to black, and yellow, magenta, and cyan are converted to
white.

Lens color state 1

Lens outline

Lens color state 0

Feed State Feed State Pilot Light
Legend background color
Legend outline

Legend text

Creating a Pilot Light
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Creating a Pilot Light
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Circular Pilot Light States
A circular pilot light has two states, on and off. You can change the lens color
and lens outline color of each state. Use the Light Off and Light On buttons to
select a different state. The last state selected is the one displayed when you
click the OK button.

Legend Plate
The legend plate describes the operation of the pilot light. This text is constant
and does not change when the pilot light changes states. From the Legend dialog
box, you can change the text color and size, the legend plate background color,
the legend plate outline color and choose how the justify the text.

Creating a Pilot Light
To create a pilot light:

1. Select the Pilot Light icon on the Tools menu.

2. Move the cross hair to the position where you want the pilot light to appear
and click the mouse.

The Quick Designer creates the pilot light button and displays the Pilot
Light Settings dialog box.

3. Enter R and the number of a register or F and the number of the flag in the
Tag field.

4. To specify the type of pilot light, select Standard or Circular.

For standard pilot lights do the following:
5. Select States... to display the State Settings dialog box.

6. Enter the text for the state.
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7. Change the Text Size if necessary

8. Change the Text, Lens, and/or Outline Color(s) if necessary; select Flash-
ing if desired.

9. Select Next to display the next state options.

10. Enter the text for the state.

11. Change the Text Size if necessary

12. Change the Text, Lens, and/or Outline Color(s) if necessary; select Flash-
ing if desired.

13. Select OK to save your changes and return to the Pilot Light Settings
dialog box or select Cancel to exit without saving your changes.

14. Select OK to save the pilot light settings and close the dialog box.

If you decide that you want to have all pilot lights appear the same way,
select Make Default button on the Pilot Light Settings dialog box to save
the current settings. The next pilot light you create automatically uses the
saved settings.

15. If you want to size the Pilot Light, move the cross hair to the desired cell,
click and hold the mouse button and drag the mouse to size the Pilot Light.
Release the mouse button and the Pilot Light is sized.

For circular pilot lights do the following:
5. Select States... to display the State Settings dialog box.

6. Select the Lens and/or Outline Color(s) if necessary; select Flashing if
desired.

7. Select Light On to display the next state options.

8. Select the Lens and/or Outline Color(s) if necessary; select Flashing if
desired.

9. Select OK to save your changes and return to the Pilot Light Settings
dialog box or select Cancel to exit without saving your changes.
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Creating a Pilot Light

10. Select Legend... to display the Legend Plate Settings dialog box.

11. Enter the Text for the pilot light.

12. Change the Text Size if necessary

13. Change the Text, Background, and/or  Outline Color(s) if necessary; select
Flashing if desired.

14. Select OK to save your changes and return to the Pilot Light Settings
dialog box or select Cancel to exit without saving your changes.

15. Select OK to save the pilot light settings and close the dialog box.

If you decide that you want to have all pilot lights appear the same way,
select Make Default button on the Pilot Light Settings dialog box to save
the current settings. The next pilot light you create automatically uses the
saved settings.

16. If you want to size the Pilot Light, move the cross hair to the desired cell,
click and hold the mouse button and drag the mouse to size the Pilot Light.
Release the mouse button and the Pilot Light is sized.
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A local message display consists of a two or more stacked lenses. Each lens
display is a different message. Only one message is visible at a given time. The
local message display requires a single controller variable. The messages can be
controlled by a flag or register variable.

The local message display can be used to show multiple messages or conditions
by assigning each message to a register, a bit in a register or a flag. The local
message display can be expanded to cover several cells so that the local message
display becomes a simple alarm message center.

A Local Message Display is used to present the status of selected registers.

To create a local message display:

1. Select the Local Message Display icon on the Tools menu.

2. Move the cross hair to the position where you want the message  to appear
and click the mouse.

The Quick Designer creates the Local Message Display and displays the
Local Message Display dialog box.

NOTE: Message display box size changed in this example

3. Enter R and the number of a register in the Tag field.

4. Select the PLC Value.

5. Select States... to display the State Settings dialog box.

6. Enter the text for the state.

7. Change the Text Size if necessary

Creating a Local Message Display
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Creating a Local Message Display

8. Change the Text, Lens, and/or Outline Color(s) if necessary; select Flash-
ing if desired.

9. Select Next to display the next state options.

10. Enter the text for the state.

11. Change the Text Size if necessary

12. Change the Text, Lens, and/or Outline Color(s) if necessary; select Flash-
ing if desired.

13. If necessary, select Next to display the next state options and repeat Steps 10
through 13. This process can be repeated as required for additional states.

14. Select OK to save your changes and return to the Local Messages Display
dialog box or select Cancel to exit without saving your changes.

15. Select OK to save the Local Messages Display settings and close the dialog
box.

If you decide that you want to have all message displays appear the same
way, select Make Default button on the Local Messages Display dialog box
to save the current settings. The next message display you create
automatically uses the saved settings.

NOTES: 1 The State Settings dialog box appears different when you select Bit for the PLC value.
2. The message displayed is determined by the actual number in the applicable register.

Importing Local Message Display Files
Local message display files (*.lmd) are text files saved with the *.lmd extension.
To import a file select Import... from the Local Message Display dialog box.
After you select a file to import, the Import File Layout Setting dialog box
appears. Using this dialog box, you can define the format and layout of the
import files.
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• Selected Fields:  Each field in the Default Fields section that is checked
appears in the Selected Fields section. You can change the sequence of the
fields by clicking a field name, then use the up and down arrows to change
its position in the list.

• Current Contents:  The Current Contents section contains the first group of
selected fields. Once you have selected a layout format for the text file, click
the Save to Default button. This will save the format for the next time you
import a *.lmd file.

• Delimiter:  A delimiter is a character that separates items in a file. The most
common is a comma separated file, similar to the following example.

Bears,dogs,cats,lions,sheep,whales,elephants

Items can also be separated by Tabs, periods, exclamations, pound, dollar,
percent, etc. Items can also be listed in one column with no separators.
Design the format of the text file so that it is easy to read and edit.

• Sample Output in File:  The first line of the imported file is shown in this
section. You can use this line to check the layout settings for proper format.
The path and file name are listed next to the section title.

• Define Values:  You can further define the attribute values of the text file by
clicking the Define Values button. In the Color section, all the colors have
their common default names. You can change BLACK to BK or any other
attribute. The 5x7 Text Size can be changed from 5x7 to SMALL. Any
attribute changed in this dialog box must match attributes in the text file.
That is, you cannot use 5x7 in the text file if you change the attribute to
SMALL. The dialog box shows the default settings for the Color, Color
Flashing, Text Justification and  Text Size attribute values.

Sample Text File
The following text file contains all of the default fields. The file is comma
separated into fields which correspond to the fields shown in the Import File
Layout Settings dialog box. A comma separated file is easy to create, and you
can use any of the delimiters shown in the Delimiter list box.

0,7x9,UL,RED,OFF,CYAN,OFF,RED,OFF,”State 0"
1,7x9,UL,GREEN,OFF,CYAN,OFF,RED,OFF,”State 1"
2,7x9,UL,BLUE,OFF,CYAN,OFF,RED,OFF,”State 2"

You can select which fields will be specified in the import file format. Fields not
specified are set to the default values shown in the following list:

• Text Size, 5x7
• Text Justify, Center
• Text Color, White
• Text Flash, Off
• Lens Color, Black
• Lens Flash, Off
• Outline Color, White
• Outline Flash, Off

You can change the default values by using the Save to Default button. Use the
Restore Default button to reset the default values to the original settings.
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Creating a Local Message Display

In the following text file, only the STATE and TEXT fields are used. The default
values are used where no field is specified.

0,"State 0"
1,"State 1"
2,"State 2"

Exporting Local Message Display Files
You can also export local message display files (*.lmd). They are saved as text
files saved with the *.lmd extension. To export a file select Export... from the
Local Message Display dialog box. After you export a file, the Export File
Layout Setting dialog box appears. Using this dialog box, you can define the
format and layout of the exported files.

From this dialog box you can select which fields you want as defaults and which
ones you want to use the previously specify attributes. For a description of the
fields on this dialog box, refer to the description of the fields for the Import File
Layout Setting dialog box.
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A Local Image Display consists of a two or more states. Each state can contain
graphic elements such as polylines or rectangles, a bitmap, text, or combinations
of graphics and text. Only one state is visible at a given time. The local image
display can be used to show a single state from a group of states by assigning
each state to a bit in a register. The following drawing shows some examples of
states.

You can think of states as a stack of pictures. States can be created by designing
the elements for each state on an unused area of a panel, copying the elements to
the clipboard, then pasting the grouped elements to the desired state. Once the
elements are pasted, they cannot be edited. If you want to change the state, you
must recreate the picture elements. This process works well for a small number
of states.

Another method of creating states is to design the elements for each state and
save the design in a library. The library feature allows you to view all the
designs and make changes before creating the local image display. This method
is recommended for a local image display with many states. The States dialog
box has a Library button for easy access to your designs.

A major design consideration for the local image display is the final size of the
display. Once you create all the states, you can size the local image display like
other panel objects. When sizing the local image display down, the minimum
size is determined by the largest object or group of objects on any one state. For
example, if you paste a large bitmap to one of the states, then you cannot size the
local image display any smaller than the size of the bitmap. So you must con-
sider the size of objects before you begin creating states.

Local Image Display Design Strategies
To ensure all states are the same size, you may want to consider using a common
graphic element for each state. First, create an unfilled rectangle. Place all
elements within the rectangle. Copy the rectangle and all elements to the clip-
board or library, then paste them to a state. Do the same procedure for each state.
When you size the local image display, the smallest size will be the size of the
rectangle, and all states will be exactly the same.

When creating images for the local image display, it is important to remember
that the local image display tool draws the graphic associated with each state
whenever the variable it is linked to changes. The graphics from the previous
states are not erased when the new graphic is drawn. So it is important that the
new graphic overwrites the old one entirely.

Creating a Local Image Display
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To make a moving image or multiple images, create a background for every
state, such as a black box. Copy the background for each new state. Add images
to each background for each new state. Now when a new state is triggered, the
background will erase all the previous image.

Specifying Register Values or Register Bits
When you specify the tag, you can select whether the register is read as a
numeric value (Word) or as discrete bits (Bit). If you read the variable as a word
value, then there will be 256 possible states. When the variable is read as
discrete bits, then there are 17 possible states (16 bit positions and 0).

After the panel is downloaded to the Quick Panel display the value in the
register determines which image is displayed. If the value of the register is 0,
then state 0 will be displayed. When the value changes to 10, then state 10 is
displayed.

To control the selection of the state by the bit in a register, select bit. If no bits
are set then state 0 is displayed. If bit 4 is set then state 4 is displayed. When
multiple bits are on, the highest order bit in the on condition determines the
selected state.  (There are 17 states using Bit).

Specifying Image States
After you have designed your images, you specify what order they will appear in
and their appearance using the States dialog box. The selections on the dialog
box are as follows:

• Justify specifies the location of the image in the image window: If the
image you paste to the current state does not fill the entire window, selecting
justify forces it to the position you want.

• Cut removes the contents of the current state.

• Copy duplicates the contents of the state to the clipboard.

• Paste copies the contents of the clipboard to the current state.

• Remove removes the selected state.

• The Library button opens the library browser.  You can select an object
from the library and copy it to the clipboard or drag it to the current state.
Use the library to store state images prior to creating the Local Image
Display.

Creating a Local Image Display
To create a local image display:

1. Select the local image display icon on the Tools menu.
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2. Move the cross hair to the position where you want the image window  to
appear and click the mouse.

The Quick Designer creates the local image display button and displays the
Local Image Display dialog box.

3. Enter R and the number of a register in the Tag field and the PLC Value.

4. Select States... to display the State Settings dialog box.

5. Select the image for the state, by pasting in a image you have created or
selecting one saved to a Library.

6. Specify how the image is justified in the image window.

7. Select Next to display the next state options.

8. Repeat Steps 5 and 13. This process can be repeated as required for addi-
tional states.

9. Select OK to save your changes and return to the Local Image Display
dialog box or select Cancel to exit without saving your changes.

10. Select OK to save the Local Image Display settings and close the dialog
box.

If you decide that you want to have all image displays appear the same way,
select Make Default button on the Local Image Display dialog box to save
the current settings. The next image display you create automatically uses the
saved settings.

NOTE: The image displayed is determined by the actual number in the applicable register.
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Creating a Clock Display
A clock display consists of a bezel and numeric readout. The default settings for
time are hours and minutes, in 12 hour format. You can add a setting for seconds
to the clock display. Military time is displayed in 24 hour format. For example,
2:30 p.m. would be 1430 hours or 14:30.

The Quick Designer software includes a tool for displaying the system time. The
tool currently does not include a dialog box for setting the time. To set the time,
you use the numeric data entry tool. To set up the clock you must create three
numeric data entry objects on a panel. Then to set the time you use the numeric
data entry tool to set the hour, minutes and seconds. For information on internal
tags used in the clock display, see Designing a Panel, Using Internal Tags in
Chapter 1.

NOTE: Use the numeric data entry tool to modify the internal clock. Do not use any other tool.

To set up the numeric data entry objects for the clock:

1. Create a new panel and use any name you like for the panel. The panel will
consist of three numeric data entry objects and one numeric data display.
The three data entry objects are used for setting the hours, minutes and
seconds. The data display is used to verify the clock setting.

2. Select the numeric data entry icon on the Tools menu.

3. Move the cross hair to the position where you want the numeric display to
appear and click the mouse.

The Quick Designer creates the numeric display button and displays the
Numeric Data Entry Settings dialog box.

4. When the Numeric Data Entry Settings dialog box appears, enter the tag
name as ~System_Hour. You must type the tag name exactly as shown,
including the tilde at the beginning.

5. Select Legend... to display the Legend Plate Settings dialog box.

6. Enter the Text for text in the legend plates to identify system hour.

7. Change the Text Size if necessary

8. Select OK to save your changes and return to the Numeric Data Entry
Settings dialog box.

9. Select Data Format... to display the Data Format Settings dialog box.

10. Change the Text Size, Justification, and any other attribute if necessary.

11. Specify the Format of the data and the number of Digits.

12. Select OK to save your changes and return to the Numeric Data Entry
Settings dialog box.

13. Select OK to save the numeric data entry settings and close the dialog box.

14. Follow steps 2 through 13 to create two more Numeric Data Entry objects,
using the tag names ~System_Minute and ~System_Second. Remember to
enter the desired text in the legend plates to identify system minute and
system second.
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15. Select the clock icon on the Tools menu.

16. Move the cross hair to the position where you want the clock display to
appear and click the mouse.

The Quick Designer creates the clock and displays the Time Display
Settings dialog box.

17. If you want, click the seconds box so the clock displays hours, minutes and
seconds. Military time refers to the 24 hour format.

18. Select OK to save the clock settings and close the dialog box.

19. Save the panel and download it to the target display. Use the data entry
operators to set the clock for your display. The display maintains the system
time between power cycles.

20. To create a clock operator on any other panel to display the time, follow
steps 15 through 18.
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Creating a Bar Graph
A bar graph consists of a legend plate and a special display that shows data in a
bar graph format. You can specify the orientation of the data displayed and the
appearance of the face plate.

Orientation
There are four ways to orient the bar graph:

• Bottom to top: as the value is increased from minimum to maximum, the
graph will grow from the bottom to the top.

• Top to bottom: as the value is increased from minimum to maximum, the
graph will grow from the top to the bottom.

• Left to right: as the value is increased from minimum to maximum, the
graph will grow from the left to the right.

• Right to left: as the value is increased from minimum to maximum, the
graph will grow from the right to the left.

Face Plate
The face plate settings allow you to select different background and outline
colors for the bar graph. A sample is shown below. Text color must be set
separately. If you load a color project into a monochrome unit, Red, Green and
Blue will be converted to Black, and Yellow, Magenta, and Cyan will be con-
verted to white.

Setting Alarms
Clicking the Advanced button brings up the Alarm Settings dialog box. The bar
graph can be divided into different sections, based on the range value and color.
Using color, the bar graph can show different colors for different alarm variable
values. The following dialog shows a single color for a range of 0 to 20.

To add more alarm ranges, click the up arrow button to the right of the Alarms
number box. Each increase adds another value box and color selection button. If
you have four ranges selected, each range can have a different color and value
setting. For example, if the ranges are: 0 to 5, 5 to 10, 10 to 15, and 15 to 20.
The minimum and maximum range values cannot be changed in this dialog box.
You can change them in the Scale Settings dialog box.

Use caution when selecting the value for the alarm range.

Bar Graph Settings
When creating a bar graph, you can set the minimum and maximum scale values
to show the full value of the tag variable or some portion of it. For example, if
the tag variable has an actual value of 0 to 65535, you can set the minimum to 0
and the maximum to 65535 to display the full variable range.

QD_94
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If you set the minimum to 0 and the maximum to 200, then the bar graph will
display only the range of the variable from 0 to 200.

The bar graph is divided into 100 segments which represent one percent of the
range value. For example, if the minimum and maximum scale range is 0 to 200,
then each increment of the bar graph is one percent, or two. Each time the
variable increases by 2, the bar graph shows a change. The alarm values operate
by changing colors at the percentage points.

If you set the value for changing colors to 5, it will not work since the changes
can only occur at the percentage increment points. The bar can change color at 4
and 6, but not at 5. You must divide the range value by 100 to arrive at the true
change points. For example, if the minimum is set to 0 and the maximum is set
to 500, then 1 percent of the range is 5. The alarm values in this case can be set
to change at increments of 5.

Creating a Bar Graph Display
A bar graph display consists of a face plate and a scale.

To create a bar graph display:

1. Select the Bar Graph Display icon on the Tools menu.

2. Move the cross hair to the position where you want the bar graph to appear
and click the mouse.

The Quick Designer creates the Bar Graph Display and displays the Bar
Graph Settings dialog box.

3. Enter R and the number of a register in the Tag field.

4. Choose the Orientation for the bar graph

5. Change the Bar Color if necessary.

6. Change the Outline Color if necessary.

7. If desired, select Flashing for the bar and/or outline colors.

8. Select Face plate... to display Face Plate Settings dialog box.

QT_32
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Creating a Bar Graph
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9. Change the Background and/or Outline Color(s) if necessary.

10.  If desired, select Flashing for the background and/or outline colors.

11. Select OK to save your changes and return to the Bar Graph Settings
dialog box or select Cancel to exit without saving your changes.

12. Select Scale... to display the Scale Settings dialog box.

13. Enter the Text for the scale.

14. Select the Text and Number Size.

15. Enter Minimum and Maximum values for the Scale Range.

16. Specify the Digits and the Decimal Position and specify the number of
Ticks.

17. Select the Scale Color and, if desired, select Flashing.

18. Select OK to save your changes and return to the Bar Graph Settings
dialog box or select Cancel to exit without saving your changes.

19. Select Simulate... to display the Simulate dialog box.

20. Enter the Set Point for the scale by sliding the elevator to the desired
position.

21. Select OK to save your changes and return to the Bar Graph Settings
dialog box or select Cancel to exit without saving your changes.

22. Select Advanced... to display the Alarm Settings dialog box.

23. Select the Color for the alarm and, if desired, select Flashing.
QD_94
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24. If you have more than one alarm, select the number of the alarm from the
Alarms field, and then specify its properties.

25. Select OK to save your changes and return to the Bar Graph Settings
dialog box or select Cancel to exit without saving your changes.

If you decide that you want to have all bar graphs appear the same way,
select Make Default button on the Bar Graph Settings dialog box to save
the current settings. The next bar graph you create automatically uses the
saved settings.

26. Select OK to save the Bar Graph Display settings and close the dialog box.
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When you read a variable from a control device, you have a single item of data
that can be displayed in a panel operator, such as a numeric display. When you
read the same variable over a period of time and save the data, you have col-
lected a data set. Showing all the points in the data set creates a trend display.
You can collect data on a particular variable over a period of time, save the data
set in a buffer and display the data in a Quick Panel trend display. You can also
collect and display data from multiple data sets.

When creating a trend display you can specify the following parameters:

• Orientation: the direction the trend is displayed. You can choose right to
left, top to bottom, left to right, and bottom to top.

• Number of samples: determines how many data points will appear on the
screen.

• Sample rate: determines how often a new sample is taken.

• Time Axis: displays the trend samples as a function of time. If the display is
left-to-right, the time axis will be on the bottom of the display. You can
display tick marks to show time marks. For example, you can display a tick
mark every 20 samples so the operator can clearly see that 20 samples have
been taken.

• Scale Settings and Range: In a left-to-right display, the scale is located on
the left side of the trend display. The scale range indicates the minimum and
maximum values. The minimum and maximum values are for the display
only and does not automatically scale the input variable.

• Number size: refers to the numbers on the scale. You specify the number of
digits and decimal positions.

• Tick marks: delineate the graph into equal segments.

• Pens: are the plots of the data set samples. The plots produce a trace in the
display. Each pen is tied to a single variable so the pen shows the data set for
the variable.

NOTE: Any variable assigned to a Trend must be a 16 bit integer type variable.

To create a trend display:

1. Select the Trend Display icon on the Tools menu.

2. Move the cross hair to the position where you want the bar graph to appear
and click the mouse.

Creating a Trend Display
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The Quick Designer creates the trend Display and displays the Trend Graph
Settings dialog box.

IMPORTANT! There have been some problems reported when using large trend displays on a 10.5"
color and 9" Mono displays. In some cases, a trend display 8 cells wide by 12 cells high,
with a sample rate of 1 second, would appear to lockup a panel. When the trend display
was reduced to 8 cells wide by 8 cells high, the panel updated normally. If you experience
this problem, reduce the sample rate from 1 second to 2 seconds or more, or reduce the
size of the trend display.

3. Select the Orientation of the trend display.

4. Chose the number of samples to appear on the screen in the Num Samples
field..

5. Specify how frequently new samples are taken in the Sample Rate field.

6. Change the Background Color if necessary.

7. If desired, select Flashing for the bar and/or outline colors.

8. Select Face plate... to display Face Plate Settings dialog box. The face
plate is the area around the trend display.

9. Select the background and outline color for the face plate.

10. Select OK to save your changes and return to the Trend Graph Settings
dialog box or select Cancel to exit without saving your changes.
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Creating a Trend Display

11. Select Time Axis... to display the Time Axis Setup dialog box.

12. Choose Draw Time Axis Legend, if desired.

13. Enter the number of tick marks per sample, if necessary.

14. Select the time axis color.

15. Select OK to save your changes and return to the Trend Graph Settings
dialog box or select Cancel to exit without saving your changes.

16. Select Scale... to display the Scale Settings dialog box.

17. Choose Draw Scale Legend, if desired.

18. Enter the text and change the text size, if necessary. Text is vertical for left-
to-right and right-to-left trends, and horizontal for top-to-bottom and bottom-
to-top graphs. Blank spaces are ignored.

19. Enter the minimum and maximum values for the scale range.

20. Enter Select the number of digits and decimal positions. A decimal position
is the number of digits to the right of the decimal point. The decimal point
counts as a digit.

21. Select the number of tick marks for the display. Tick marks are placed next
to the trend to delineate the graph into equal segments.

22. Change the number size, if necessary. Number size refers to the numbers on
the scale.

23. Select the scale color and, if desired, select Flashing.

24. Select OK to save your changes and return to the Trend Graph Settings
dialog box or select Cancel to exit without saving your changes.
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25. Select Pens... to display the Pen Setup dialog box.

26. Change the default name for the pen, if desired.

27. Enter the Tag name for the pen.

The values for the input range and the scale range appear.

NOTE: You cannot edit the values for range or scale. They are fixed at -32768 to +32767.

28. Select the line style and pen color. Select Flashing, if desired.

29. To add a new pen, click New

30. Choose the parameters for the pen.

31. Select OK to save your changes and return to the Trend Graph Settings
dialog box or select Cancel to exit without saving your changes.

If you decide that you want to have all trend graphs appear the same way,
select Make Default button on the Trend Graph Settings dialog box to save
the current settings. The next trend graph you create automatically uses the
saved settings.

32. Select OK to save the Trend Graph Display settings and close the dialog
box.
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Creating a Analog Meter Display
You can create a analog meter for display on your touch screen. You can choose
an analog meter that goes from the minimum value to 180 degrees or one that
goes from the minimum value to 360 degrees, you can also choose to fill the area
from the minimum value to the current value. The following illustration shows
the 180 degree meter.

The following illustration shows the 360 degree meter.

When you select the 360 meter, you can also choose its orientation. The 360
degree meter can have the starting point (minimum setting) at the top of the
meter or the bottom. The bar on the meter face moves clockwise from the
minimum value to the maximum value.

To create an analog meter:

1. Select the Meter icon on the Tools menu.

2. Move the cross hair to the position where you want the meter to appear and
click the mouse.

The Quick Designer creates the meter and displays the Meter Settings
dialog box.
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3. Enter R and the number of a register in the Tag field.

NOTE: Any variable assigned to a Meter must be a 16 bit integer type variable.

4. Change the Bar Color and select Flashing if desired. The bar color is the
movable portion of the meter, similar to a bar graph.

5. Select Filled if desired. The movable portion of the meter is set to be a
single line, similar to the needle on a pressure gauge. Selecting Filled will
fill the area from the minimum value to the current value. The fill color is
same as the bar color.

6. Select the shape of the analog meter (180 or the 360 degrees).

If you select the 360 meter, the Orientation list box appears on the Meter
Settings dialog box.

7. In the Orientation list box , select the location of the starting point, either
top of the meter or the bottom. The bar on the meter face moves clockwise
from the minimum value to the maximum value. Use Simulate to see the
action.

8. Select Face plate... to display the Face Plate Settings dialog box.

9. Change the Background and/or Outline Color(s) if necessary.

10.  If desired, select Flashing for the background and/or outline colors.

11. Select OK to save your changes and return to the Meter Settings dialog box
or select Cancel to exit without saving your changes.
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Creating a Analog Meter Display

12. Select Scale... to display the Scale Settings dialog box.

13. Enter the Text for the scale.

14. Select the Text and Number Size.

15. Enter Minimum and Maximum values for the Scale Range.

16. Specify the Digits and the Decimal Position and specify the number of
Ticks.

17. Select the Scale Color and, if desired, select Flashing.

18. Select OK to save your changes and return to the Meter Settings dialog box
or select Cancel to exit without saving your changes.

19. Select Simulate...

The Quick Designer displays the Simulate dialog box.

20. To view the meter as the data value is changes between the minimum and
maximum values, use the scroll bar to change the value.

21. Select OK to save your changes and return to the Meter Settings dialog box
or select Cancel to exit without saving your changes.

If you decide that you want to have all meters appear the same way, select
Make Default button on the Meter Settings dialog box to save the current
settings. The next meter display you create automatically uses the saved
settings.

22. Select OK to save the meter settings and close the dialog box.
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The print button prints the current panel to a printer attached to the serial
(download) or parallel port. For information about hardware connections, see
Appendix B, Communications Reference, and the section on the printer port in
the Chapter 4, Alarms. The Print button is similar to a push button, except you
do not need to set a tag variable. The button is permanently assigned an internal
variable that controls printing. Print button can be one of three styles, standard,
simple or circular.

Standard Print Button
The standard print button consists of a bezel and legend plate. The bezel is the
frame around the legend plate. The bezel can be one color when the button is
idle and a different color when the button is touched. You can change the bezel
color, the touch color and the bezel outline color. The legend plate contains the
text and the background. You can also change the text color, legend plate back-
ground color and legend plate outline colors.

Simple Print Button
The simple button is similar to the standard button except it has no bezel. The
simple button is a legend plate and text and has more room for text characters
than the standard button. You can change the text color, legend plate background
color and legend plate outline colors.

Creating a Print Button
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Creating a print button

Circular Print Button
The circular button consists of a bezel and legend plate. The bezel is the circular
section in the center of the button. The ring around the bezel is the touch indica-
tor. The touch indicator can be one color when the button is idle and a different
color when the button is touched. You can change the bezel color, the touch
color and the bezel outline color. The legend plate contains the text and the
background. You can also change the text color, legend plate background color
and legend plate outline colors.

Creating a Print Button
To create an analog meter:

1. Select the Print icon on the Tools menu.

2. Move the cross hair to the position where you want the meter to appear and
click the mouse.

The Quick Designer creates the meter and displays the Print Button
Settings dialog box.

3. Select Bezel... to display the Bezel Settings dialog box.

4. Change the Bezel, Outline, and/or Touch Color(s) if necessary; select
Flashing if desired.

5. Select the Simulate button to check your changes.
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6. Select OK to save your changes and return to the Print Button Settings
dialog box or select Cancel to exit without saving your changes.

7. Select Legend....

Quick Designer displays the Legend Plate Settings dialog box.

8. Enter the Text for the button.

9. Change the Text Size if necessary

10. Change the Text, Background, and/or  Outline Color(s) if necessary; select
Flashing if desired.

11. Select OK to save your changes and return to the Print Button Settings
dialog box or select Cancel to exit without saving your changes.

If you decide that you want to have all print buttons appear the same way,
select Make Default button on the Print Button Settings dialog box to save
the current settings. The next print button you create automatically uses the
saved settings.

12. Select OK to save the Print Button settings and close the dialog box.
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Creating a Video Display
The video display icon only appears when you select the 10.5" Color Video as
the display type during Setup. Once you have selected the color video display,
you can use the video tool.

• Transparency Modes: There are three modes to choose from when display-
ing video on the Quick Panel display. The options allow for a wide range of
display options and panel design functionality.

Video covers all objects mode: The video appears over all objects. You can
hide a button behind the display.

When you select Video shows only in objects of this color or Objects of
this color appear through video, the Video Display Settings dialog box
changes to show a color selection option.

Video shows only in objects of this color: The panel only displays the
video when an object of the selected color is in front of the video display.
The object must be placed in the foreground. For example, if you create a
push button with a red legend plate and the selected color is red, then the
video will only be shown on the legend plate. The video does not appear on
parts of the push button that have a different color.

Objects of this color appear through video: Any object of the selected
color will appear on the video display. For example, if you create a push
button with a green bezel, and the selected color is green, then the bezel part
of the button will appear on the video display.

NOTE: In order for objects to work with transparency, you must place them in the foreground or in front
of the video display.

• Button Options: Use the # of Buttons radio buttons on the Video Display
Settings dialog box to select the number of buttons that appear in the video
display. The buttons are located below the video display and size as the
legend plate is sized. The video display is always 300 x 200 pixels. From the
Button Control Settings dialog box, you can specify which of the three video
sources the buttons select. Each button also has its own title.

• Touch Input Off: Turns off the touch screen in front of the video display.
This does not effect objects around the video display window.

Video Display Channel Selection and Color Options
The Control Button Settings dialog box is used to setup the buttons that appear
on the video display. The buttons select which video source channel is being
displayed. You can customize the buttons for your application. The Button No
information box displays the assigned button number. The Channel No list box
selects the video source for the button. Each button can select from CH0, CH1,
or CH2. CH3 is not used in this product. See Appendix A for information about
hooking up video inputs to a Quick Panel display
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The text, lens, outline, bezel and bezel touch colors appear on the buttons as
shown below:

Bezel color

BUTTON (0) BUTTON (1)

Outline color

Lens color

Text color

Bezel touch color

You can change the background and outline colors of the video display using the
Legend Plate Settings dialog box. These colors are constant and do not change.
The background and outline sections are shown in the following drawing.

BUTTON (0) BUTTON (1)

VIDEO DISPLAY (0)

Outline color

Background color
Title

A video display can be set up to display different titles, depending on which
button on the bottom of the video display the operator pushes. The number of
buttons selected determines the number of titles. You specify the titles using the
Title Settings dialog box.
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Creating a Video Display

QD_215

In the drawing below, pressing button 0 displays title 0, and pressing button 1
displays title 1.

BUTTON (0) BUTTON (1)

VIDEO DISPLAY (0)

Title (0) for
Button (0)

Creating a Video Operator
To add a video operator to a panel:

1. Select the video icon from the tools menu.

2. Move the cursor to the panel area where you want the video display to
appear and click the mouse.

The video display appears in a 300 pixel wide x 200 pixel high area, along
with operator buttons and legend data. The Video Display Settings dialog
also appears.

3. Select the Transparency Mode for the video display.

4. If you selected Video shows only in objects of this color or Objects of this
color appear through video modes, click the list box next to Selected
Color and choose the color you want.

5. Click one of the # of Buttons radio buttons to select the number of buttons
on the video display.
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6. Click No Title checkbox to remove the title from the video display.

7. Click the Touch Input Off check box to turn off the touch screen in front of
the video display.

8. Click Legend... to display the Legend Plate Settings dialog box.

9. Click the list boxes next to the Background and/or Outline Color and
choose the color you want.

10. Select OK to save your changes and return to the Video Display Settings
dialog box.

11. Click Titles... to display the Title Settings dialog box.

12. Enter the title text in the Video Display (n) box.

13. Click one of the Text Size radio buttons to change the font size for the text if
necessary.

14. Change the text justification by clicking one of the Justify buttons.

15. Click the list box next to the Text Color and choose the color you want.

16. Select Flashing if desired.

17. Use the Next and/or Previous buttons to select different titles.

18. Follow steps two through six to specify the video display text.

19. Continue clicking the Next and/or Previous buttons to finish entering title
text.
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Creating a Video Display

20. Select OK to save your changes and return to the Video Display Settings
dialog box.

21. Click Buttons... to display the Control Button Settings dialog box.

22. Enter the title text in the BUTTON(n) box.

23. Click one of the Text Size radio buttons to change the font size for the text
if necessary.

24. Change the text justification by clicking one of the Justify buttons.

25. Click the list box next to the Text, Lens, Outline, Bezel, and Touch
Color(s) and choose the color you want.

26. Select Flashing if desired.

27. Use the Next and/or Previous buttons to select different buttons.

28. Follow steps two through six to specify the button text and appearance.

29. Continue clicking the Next and/or Previous buttons to finish entering
button text and appearance.

30. Select OK to save your changes and return to the Video Display Settings
dialog box.

If you decide that you want to have all print buttons appear the same way,
select Make Default button on the Print Button Settings dialog box to
save the current settings. The next print button you create automatically
uses the saved settings.

31. Select OK to save the video display settings and close the dialog box.
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Introduction
The keypad option adds external keypads that surround the touch screen. The
keypads are used in place of the touch screen or along with the touch screen. For
example, instead of touching the Quick Panel screen to activate a Push Button,
you can press an external keypad. You can also assign an external keypad to
simulate a push button, selector switch, goto panel button, numeric data entry,
print button or word button. Simulating operators saves screen space. Any panel
operator with a bezel can be assigned to an external keypad.

The addition of external keypads to the standard touch screen allows several
options. For example, a Push Button can:

• Work normally without using an external keypad.
• Be assigned to an external keypad.
• Work normally and with an external keypad.
• Be simulated by a keypad and not appear on the touch screen.

Keypad Layout
Keypad designations are permanently assigned, but the physical legends can be
changed to suit your application. That is, L3 will always be in the same location,
but the legend for L3 can be changed. Some of the keypad designations do not
appear on the keypads. They are included in the drawing for reference. The
unmarked keypads are T0, B0, T5, B5, and A0 through A7.

Reserved and Programmable Keys
The keypads are divided into reserved keys and programmable keys. The nu-
meric keys, including the blank keys above the numeric keys, cannot be assigned
and are the reserved keys. The programmable keys are as follows:

• The first series of keys are the ones on the left and right sides of the display.
The keys are designated L1 for left 1, R2 for right 2, and so on.

• The next series of keys are the two rows below the display. The top row is
designated T0 for top 0, T1 for top 1, and so on. The bottom row is desig-
nated B0 for bottom 0 like the ones above.

• The final group of programmable keys are located below the numeric
keypads and are designated A0 through A7.
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You can assign a keypad to a button from the Advanced dialog box The Ad-
vanced dialog box is accessible from in the any of the settings dialog boxes,
such as the Push Button Settings dialog box.

Once a button is given a key assignment, it can be connected to the touch screen
and the keypad simultaneously. If you check the Touch disabled checkbox, the
button is disabled on the touch screen and it only work with the assigned exter-
nal keypad. You can display a list of all keypad assignments by selecting Key-
pad Assignments on the Tools menu.

Keypads and Numeric Data Entry
When a keypad is assigned to a numeric data entry button, the data entry keypad
on the touch screen and the external numeric keypad operate the same. If you
disable the touch screen, the data entry keypad no longer appears on the touch
screen. Only the legend text and data entry fields appear. You must use the
external numeric keypad to enter data.

If you disable the touch screen for the numeric data entry operator, you cannot
activate the numeric data entry button by touching the screen. The only way to
activate the button is by pressing the assigned keypad and use the external
numeric keypads to enter data.

Keypads and Alarms
When an alarm is triggered, the alarm message appears on the panel in an alarm
window. The operator touches the MODE button to activate the alarm manage-
ment page. If you assign a keypad to an Alarm window, the alarm management
page has an additional row showing keypad assignments.

The alarm management page function keys (Up, Down, Ack, etc.) have perma-
nent keypad assignments. Up is A0, Del is A3 and so on. The touch screen and
the keypads work in parallel. If the touch screen is disabled, only the keypads
operate the alarm page functions.
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Assigning Keypads
Simulating Panel Objects with Keypads

You can assign a keypad to simulate any of the following panel operators, even
though there is no panel object visible on the screen:

• Push Button
• Goto Panel Button
• Print Button
• Word Button
• Selector Switch
• Numeric Data Entry

To create a simulated panel object:

1. Select Keypad Assignments from the Tools menu.

The keypad - key assignments dialog box appears.

2. Select a key to assigned to the simulated panel operator from the Key list
box.

3. Select an operators to simulate by clicking the appropriate key assignment
button. When you click one of the simulate keys, the rest of the buttons are
grayed out.

4. Select the Attributes button to open the Settings dialog box.

In this example, clicking the Attributes button opens the Goto Panel
Settings dialog box.

5. Enter the panel name and select the OK button.

When you press the A0 key, the panel name you selected will be displayed.
This is the same operation as the Goto Panel Button, but without the panel
operator taking up screen space.
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Keypad Assignments
You can view all the keypad assignments by going to the Tools menu, selecting
Keypad assignments, then selecting the Key list box. You can change the at-
tributes of any simulated operator by selecting the keypad from the list, then
clicking the Attributes button.

NOTE: Simulated operators are marked as Simulated.

Viewing  Keypad Assignments
To view the keypad assignments, go to the View menu and click the Object Key
Display. The keypad tag display is similar to the object tag display.

The keypad tag is displayed in the bottom left corner of the operator and pro-
vides a quick visual check to see which panel operators have keypads assigned.
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Introduction
When you compile and download a project, Quick Courier is the program that
downloads the new panels to your Quick Panel display. Quick Courier can both
send or receive data between your computer and a Quick Panel display. A
download sends a file from the computer to the display. When compiling a
project to download, the compile and download operation should continue
without manual intervention. At the start of a download procedure , Quick
Courier tests all panels for proper format. Any errors in the panels must be
corrected before a download operation can begin. Quick-Courier detects the end
of a successful download and automatically terminates.

The following files are compiled and are included as part of the download:

• Configuration file: The configuration file configures a target display for
operation with your Controller. The configuration information includes the
name of the panel that appears after a power cycle, screen saver time-out,
the serial port parameters, and other option settings. Without the proper
configuration information, the target display cannot communicate with your
Controller.

• Panels: The panels to be displayed on the target display.

• Protocol driver file: You must have the correct protocol driver loaded into
the target display in order to communicate with your Controller. During the
download operation, the target display is tested to determine if a new display
device executable file is needed.

• Additional files: Other files, such as, alarm files, may also be included in
the compiled download file.

You also have the option of downloading the project file. The project file is not
part of the compiled download file, but it can be downloaded to the Quick Panel
display. It contains all the project information in raw format and is similar to an
exported project file. This file can later be uploaded and used like an imported
project file.

The Quick Manager tools used to compile and download files are as follows:

Compile and download project: Compiles the current project and
downloads it to the computer. When you compile and download a file for
the first time, you need to choose an unused communications port.

Compile project: Compiles the current project and allows you to save it
to a selected directory. Using the compile only option you can compile a
file without having to download it to a connected Quick Panel display.
You can download the file to one or more Quick Panel displays. To add
the current project file to the file you are compiling, click the download
project button before you compile.

Download project: Creates a project file and downloads it to the Quick
Panel display. Press this button then the standard download button and
the current project will be compiled along with the project file and sent to
a Quick Panel. Press this button then the new Compile File button, and
the current project will be compiled and saved with a project file. The
button is reset after a compile is completed.
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Upload project: Uploads a project file from a Quick Panel display. To
upload a project file, it must be saved with the downloaded file. An
uploaded project file is saved the same way as an imported project. The
project can then be edited using Quick Designer software, compiled and
downloaded back to a Quick Panel display, or saved for other purposes.

Download from File: Downloads the compiled file (*.cmp) you select to
a Quick Panel display.
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Compiling and Downloading
Target Display Condition

Quick Courier (version 1.06 or later) software has the ability to read the display
device status and determine which protocol has been loaded. Once Quick
Courier reads the status, it can automatically download a new application,
including a new display device executable file if necessary. To enable this
feature in Quick Courier, you MUST have a version 1.06 (or later) device
executable driver loaded in the target display.

If you are upgrading to a new version software, you must download a new
display device executable file. New factory units do not have a display device
driver installed. When you apply power to a new unit, it displays a message
indicating it is ready to receive a display device executable file.

You can force Quick Courier to download a display device executable file by
checking the Update display device executable box. Downloading a new display
device executable file is generally handled by Quick-
Courier, because it can determine the state of the display and load any necessary
files.

Download Operation
Before you download a file to a Quick Panel display, do the following tasks:

• Install power to the target display device. See the Hardware Reference
manual for details.

• Connect the CTC 4171 cable from your computer port to the target display.
The following drawing shows a Quick Panel Jr. and a CTC 4171 cable
connected to the download port.

+ SIO/CN3
To serial port

CTC 4171

_

IMPORTANT! Do not use a HMI-CAB-C50 cable.

• Make sure the settings in the Setup dialog boxes are correct for your serial
port. Make sure you have at least one panel with valid operators.

• Turn on the power to the display. Click the download button and note the
operator prompt messages. If you run into problems, see the Communication
and Download Trouble Shooting in this chapter.
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Compiler
When you select the download icon or the Download option from the File menu
the compiler program starts automatically. The compiler program checks the
panel designs for possible errors and assembles the panel information for the
download operation. All of the other files required for a download, except a
project file, are included in the compile. A sample compile operation information
box is shown below.

If the compiler finds an error, it stops and displays the name of the panel and the
error condition. Select the Cancel button to exit the compiler program and fix
the panel.
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Quick Courier
When the compiler completes assembling the files, it hands the compiled file
over to Quick Courier, which sends all files to the target display. Quick Courier
can read the display device status and determine which model have been speci-
fied during project setup. If you have selected a different display model, Quick
Courier displays an error message and cancels the download. If all the project
setup information is correct, Quick Courier reads the status and automatically
downloads a new application, including a new display device executable file if
necessary.

When the application download is complete, Quick Courier closes and the Quick
Manager program returns. If you have selected a default panel, Quick Panel
displays it when the download is done. If no default panel is selected, the Quick
Panel display shows the following prompt:

Press To Press For
Run Next
Screen Screen
filename

Communications Port:
The first time you
download a file, you must
select an unused
communication port on
your computer. Quick
Courier looks for and
displays a list of unused
ports and you must select
a port. Once you select
the port, Quick Courier
uses the port to connect
to the target display. The
status of some of the
signal lines from the
target display are shown
next to the comm port list
box.

Display information: Once a download begins the  dialog
box expands to show additional information about the target
display.

Event log: Keeps
track of all operator
prompt messages and
allows you to view
them in a scrollable
window.

Progress Bar: Shows
the progress of the
download operation.

Project information:
Lists the name of the
project and the
location of the
download file.
Checking the Update
display device
executable box forces
Quick Courier to
download a display
device executable file.
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Communications and Download Trouble Shooting
Communication Problems

If you experience problems running Quick Courier on systems with a Fax/
Modem card, it may be due to the corruption of the Windows 3.1 COMM.DRV
driver. The software for your Fax/Modem card may have replaced the original
communication driver with a nonstandard driver. To install the correct Windows
communications driver:

1. Edit the SYSTEM.INI file and comment out the existing COMM.DRV line
by placing a semicolon at the beginning of the line.

2. Add the following line:
COMM.DRV = COMM.DRV

Troubleshooting Guide
1. Are you using a CTC 4171 cable? The CTC 4171 cable converts RS-232

from your computer to TTL levels that the Quick Panel can accept through
the download port. Other cables do not work.

Solution: Acquire a CTC 4171 cable.

2. Is your PC at least a 386DX/25 with 4M of RAM? If you are using
anything less it is possible that it is taking too long for your PC to respond to
the Quick Panel when downloading the executable. The executable down-
load is very timing dependent.

Solution: Try a faster computer.

3. Are you using the Standard Windows communication driver? Open your
C:\WINDOWS\SYSTEMI.INI file. Look for a line that starts out “comm.drv
=”. If you are using the standard Windows comm driver the line will say
comm.drv = comm.drv. If this line says anything else, you are not using the
standard Windows comm driver and this driver may not be directly compat-
ible with all windows applications.

Solution: Comment out this line with a semicolon and insert another line that
reads “comm.drv = comm.drv”. Now restart windows and try the download
again.

4. Are your Comm ports OK? Exit windows and at the DOS Prompt in the
Windows directory, type MSD<Return>. Once MSD examines your system,
zoom into the report on comm ports and note the following.

a. You must have only 2 comm ports available. If you have more than 2
comm ports, you may have an IRQ conflict.

Solution: Reconfigure your PC until this condition goes away.

b. Is the UART Chip for these comm ports a 16550? If your PC uses this
chip, there is a bug in Microsoft windows V3.1 and V3.11 that may not
allow you to run communication programs correctly.

Solution: The fix for this bug is available from Microsoft or from TCP’s
BBS (708-345-5880 -get file W31COM.EXE if using Windows V3.1 or
WG1001.EXE if using V3.11. These files are self extracting and in-
cludes instructions on installation).
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5. Are you using a lap top? If you are using a lap top it is possible that power
management is probably shutting down certain devices in your PC during a
download.

Solution: Turn off all power management and try again. Consult your PC
manufacturer for details.

6. Has your hard disk been damaged? At DOS Prompt run chkdsk.exe. If it
reports any problems, areas of your disk may have been damaged. These
may include the Quick Panel Editor.

Solution: Run chkdisk with /f option or scandisk to repair, then reinstall the
Quick Panel Editor, try again. If still unable to down load reinstall Windows
then try again.

Other recommended troubleshooting procedures include:

• Try downloading from another comm port on your PC.

• Try downloading from another PC.

• Try a different CTC 4171 cable.

Communications and Download Trouble Shooting
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Installing Quick Designer
To install Quick Designer follow these procedures:

1. Exit all Windows programs before installing Quick Designer.

2. Insert CD into CD-ROM drive.

3. Click the Start menu with the mouse and select Run.

4. When the Run dialog box appears, select Browse....

5. When the Browse dialog box appears, select your CD-ROM drive.

6. Select Setup.exe and then select Open.

7. When the Installation program starts, read each screen carefully and follow
its instructions.

8. We recommend you install Quick Designer in its default directory
(C:\Quick). If you change from the default, ensure all directories in the new
path conform to MS-DOS conventions.

9. Choose one of the following installation types:

• Typical installs the software and its most popular extras.
• Compact installs the minimum software with no extras.
• Custom allows you to choose components to install.

The Installer shows the space required for the options you want above
the space available on your hard drive.

10. When the installation is complete, The installation program prompts you to
restart your computer or continue. After you restart your computer, you can
begin using Quick Designer.
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Connecting a Quick Panel Display
Serial Interface Port

The serial interface port connects the Quick Panel to your controller.  Factory
cables are cut to approximately 12', which is suitable for most applications. If
you need a longer cable, you can order one. RS-232 cables are reliable up to
approximately 50 feet. The serial interface pin assignments are shown in the
following table.
PIN # NAME PIN # NAME

1 FG Frame Ground 14 Reserved

2 TXD Transmit Data 15 TXB Sending Data -

3 RXD Receive Data 16 RXB Receiving Data -

4 RTS Request to Send 17 No connection

5 CTS Clear to Send 18 CTSB Clear to Send -

6 Reserved 19 DTRB Request to Send -

7 GND Signal Ground 20 DTR Data Terminal Ready

8 CD Carrier Detect 21 CTSA Clear to Send +

9 TRMX Terminator RXA 22 DTRA Request to Send +

10 RXA Receiving Data + 23 Reserved (BUZZGND)

11 TXA Sending Data + 24 Reserved

12 No connection 25 Reserved (BUZZOC)

13 No connection

Download Port
The download port, also known as the Tool/CN3 port, has two functions. Its
primary uses is to download application files from a computer to the target
display. The secondary use is to print alarm messages to a serial printer. Use the
printer option in the configuration menu to enable the download port (Port 1) as
a printer port. The download port uses TTL signal levels and requires conversion
to RS-232. The CTC 4171 cable, which is used for downloading files, converts
the TTL signals to RS-232. Use the printer cable to connect a printer to the
download port. Both cables are equipped with a 9-pin D connector that is AT
compatible. The download port connector is an 8-pin mini-DIN style. The port
settings are fixed at 9600 Baud, 8 bits, no parity. The pin assignments for the
CTC 4171 cable are shown in the drawing on the next page.
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IMPORTANT! The information in the illustration above, is considered proprietary. This information is
provided as a convenience to our customers. You are not authorized to construct this
cable. Unauthorized cables are not supported.

Download
The download process involves connecting your computer to a target display and
transferring communication and panel information to the target display. The
download operation is done after you have selected the controller protocol, setup
the communication options, and designed at least one panel. Once the download
operation is complete, the display is connected to your controller and the display
becomes the operator interface.

CTC 4171 Cable
The CTC 4171 cable connects your computer to the circular DIN connector on
the target display. This cable is used to download files created by Quick De-
signer software in your computer to the target display.

The 9-pin AT connector housing contains an electronic circuit that makes the
signals from both devices compatible. This cable also includes custom electron-
ics.

8-Pin circular DIN

CTC 4171
to QUICKPANEL display

To IBM AT 9-Pin

9-Pin female D-sub

CTC 4171
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CTC 4171 Cable Connection
The CTC 4171 cable is connected to the circular DIN connector port on the
target display as shown below. The 9-pin connector is attached to a serial port on
your AT compatible computer.

+ SIO/CN3
To serial port

CTC 4171

_
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Connecting Video Inputs and Adjusting Color
Connecting Video inputs

The Video Quick Panel has the standard serial, printer and tool ports. It also has
three NTSC BNC video inputs. The following drawing shows the location of the
ports and input connectors.

Serial port Printer port Tool port

Chanel 0
video

Chanel 1
video

Chanel 2
video

The video source must be NTSC. The video output from a camcorder or VCR is
usually an RCA phono plug type connector. One method of connecting these
video sources is adding an RF adapter to the Video Quick Panel. A typical phono
plug to BNC connector can be found at a local Radio Shack under the part
number 278-254. Many computer stores sell BNC cables for use in networks.
These cables can be used to connect video signals that require BNC style
connectors.

Color Adjustments
You can adjust the contrast, brightness, and color balance on a Quick Panel
display by going into setup mode. You can enter setup mode during power-up or
when the unit is in run mode.

Color Adjustments during Power Up
To enter SETUP mode during power up:

1. Power up the unit and press and hold the upper corners of the display.

The display enters setup mode and displays the main menu.

2. Press button 1, INITIALIZE

3. Press button 1, SYSTEM ENVIRONMENT SETUP

4. Select button 6, VIDEO DISPLAY ADJUSTMENT.

5. Select the INPUT CHANNEL at the bottom of the screen by pressing one of
the channel numbers.

The video panel appears on the left side of the screen.

6. Set the brightness, contrast, and color or press the default button.

7. When you are finished, press the SET button to exit the adjustment setup.

8. Press MAIN MENU, then press RUN.

The display enters run mode.
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Color Adjustments when in Run Mode
To enter SETUP mode during run mode:

1. While the unit is in run mode, press the bottom corners and the upper right
corner at the same time.

2. Press the OFFLINE button on the bottom of the screen.

The unit enters setup mode and displays the main menu.

3. Press button 1, INITIALIZE

4. Press button 1, SYSTEM ENVIRONMENT SETUP

5. Select button 6, VIDEO DISPLAY ADJUSTMENT.

6. Select the INPUT CHANNEL at the bottom of the screen by pressing one of
the channel numbers.

The video panel appears on the left side of the screen.

7. Set the brightness, contrast, and color or press the default button.

8. When you are finished, press the SET button to exit the adjustment setup.

9. Press MAIN MENU, then press RUN.

The display enters run mode.

Important! Do not change any other settings when in setup mode.
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Date Stamp System Variable
The Quick Designer software includes a tool for creating an alarm display. One
of the options in the alarm message is the display of a date stamp. The method
for setting the correct date is similar to setting the time. (Described in Chapter
6.)

To use the date stamp system variable:

1. Select the numeric data entry icon on the Tools menu and create a data entry
object on the panel.

2. When the Numeric Data Entry Settings dialog box appears, enter the tag
name as ~System_Day. You must type the tag name exactly as shown,
including the tilde (~) at the beginning.

3. Specify the Minimum and Maximum values for the Input Range.

4. Select Bezel....

5. When the Bezel Settings dialog box appears, specify the bezel settings.

6. Select OK to save your changes and return to the Numeric Data Entry
Settings dialog box.

7. Select Legend....

8. When the Legend Plate Settings dialog box appears, enter the Text for the
numeric data entry and change any other parameters as necessary.

9. Select OK to save your changes and return to the Numeric Data Entry
Settings dialog box.

10. Select Data Format....

11. When the Data Format Settings dialog box appears, specify the Format of
the data and the number of Digits.

12. Specify and/or change any other parameters as necessary.

13. Select OK to save your changes and return to the Numeric Data Entry
Settings dialog box.

14. Select OK to save the data entry settings and close the dialog box.

15. Repeat the procedure for ~System_Month and ~System_Year.
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Display Contrast System Variable
Using the system variables and internal tags, you can change the contrast of the
target display to suit different viewing conditions.  To adjust the contrast, the
system variable ~System_Contrast must be set to a value from 1 to 7. This can
easily be done by using two Word Buttons: one to increase and one to decrease
the value of ~System_Contrast. You can see the contrast change as the value is
increased or decreased.

To use the display contrast system variable:

1. Select the Word Button icon on the Tools menu and create a word button on
the panel.

2. When the Word Button Settings dialog box appears, enter the tag name as
~System_Contrast. You must type the tag name exactly as shown, including
the tilde (~) at the beginning.

4. Specify the Action as Add and set the Value to 1.

5. Specify the Style and Mode.

6. Select Bezel....

7. When the Bezel Settings dialog box appears, specify the bezel settings.

8. Select OK to save your changes and return to the Word Button Settings
dialog box.

7. Select Legend....

8. When the Legend Plate Settings dialog box appears, enter the Text for the
numeric data entry and change any other parameters as necessary.

9. Select OK to save your changes and return to the Word Button Settings
dialog box.

10. Select OK to save the Word Button settings and close the dialog box.

11. Place a second Word Button on the panel using ~System_Contrast as the
tag name and specify the Action as Subtract and the Value as 1.

12. Follow step 5 through 10 to set up the decrease contrast button.
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Communication Status System Variable
The communication status is a bit that can be used to turn a pilot light on or off
to indicate the status of the communication protocol. When the bit is equal to 0,
the communication protocol is normal. The tag variable is
~System_Comm_Status.

NOTE: System Comm Status is an internal tag that is available only on QPJ-1
and QPI-1 models.

To use the communication status system variable:

1. Select the Pilot Light icon on the Tools menu and create a pilot light button
on the panel.

2. When the Pilot Light Settings dialog box appears, enter the tag name as
~System_Comm_Status. You must type the tag name exactly as shown,
including the tilde (~) at the beginning.

3. Select States....

4. When the State Settings dialog box appears, enter the text for the ON and
OFF states.

5. Specify and/or change the other parameters, such as Text Size if necessary

6. Select OK to save your changes and return to the Pilot Light Settings
dialog box.

7. Select OK to save the pilot light settings and close the dialog box.
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Introduction
The Quick Panel Compiler, SSC, provides a number of generation options.
These options allow you to change the run-time appearance of some of the
Quick Panel objects as they are generated. Some of these options also control
the execution of the compiler. To change or use these options, you must create
an file called SSC.INI that specifies the settings for each option. It must be
located in the directory where the Quick Designer applications are installed.

Format of the SSC.INI File
The SSC.INI file contains several sections, each of which consists of a group of
related settings. The sections and settings are listed in the SSC.INI file in the
following format:

[section name]
keyname=value

• In this example, [section name] is the name of a section. The enclosing
brackets, [ ], are required, and the left bracket must be in the left most
column on the screen.

• The keyname=value statement defines the value of each setting. A keyname
is the name of a setting. It can consist of any combination of letters and
digits in uppercase or lowercase, and it must be followed immediately by an
equal sign (=). The value can be an integer, a string, or a quoted string,
depending on the setting.

To include comments, begin each line of a comment with a semicolon (;).

How to Read the  SSC.INI File Listings
The SSC.INI file settings are listed alphabetically within each section. The
settings do not appear alphabetically in the SSC.INI file. To change a setting,
you need to search for it within the appropriate section of the SSC.INI file. The
file settings list the syntax, default value, purpose, and recommended method for
changing each setting, using the following format:

SettingName=<value-type>

• Default: The default value for this setting.

• Purpose: The function of the setting and its default value (if applicable).

• To change: The recommended method for changing the value of this setting.

• <value-type>: Indicates whether the value should be an integer, a letter, a
range of numbers, or something else.

Changing Settings
When the Setup program creates the SSC.INI file, it assigns default values to the
settings. Some settings that are listed in this document may not appear in your
SSC.INI file. You can use a text editor, such as Notepad, to edit the SSC.INI file
directly.

NOTE: Do not use a formatting editor, such as Write; it can corrupt your SSC.INI file.
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You must use this method to change the settings that you cannot change by
using Control Panel. After you have edited the SSC.INI file, you must restart
Quick Designer for the settings to take effect. Be careful when using a text
editor to edit the SSC.INI file. Incorrect changes to the SSC.INI file can
cause unexpected results when you run the compiler.

CAUTION: Always back up your SSC.INI file before you make changes, so that you can restore
the original file in case you accidentally damage the SSC.INI file or make changes
that cause problems when the compiler is executing.



C-4 Quick Designer User Guide

Control Technology Corporation proprietary, Reproduction or distribution forbidden.

[ssc-option] Section Settings
The [ssc-option] section contains settings that affect general operation of the
compiler, such as sound and error file formats. The [ssc-option] section can
contain the following settings:

Sound=<0> or <1>
Default: 0

Purpose: Specifies if the compiler uses sound to flag specific events during the
compilation cycle. You must have sound support enabled in Windows for this
feature to work. The following entries must be specified in the [sounds] section
of WIN.INI:

SSCPrimoFinis=<filename> Smart Screen Compiler Completion (used when
the compiler finishes correctly)

SSCError=<filename> Smart Screen Compiler Error (used when the
compiler finds an error)

SSCSnafuFinis=<filename> Smart Screen Compiler Failure (used when the
compiler finishes with errors)

SSCBegin=<filename> Smart Screen Compiler Start (used when the
compiler starts)

Filename is the complete path and file specification for the *.WAV file to be
played for the specific event.

TDFormat=<format string>
Default: %y-%m-%d %H:%M %Z

Purpose: Controls the format of the time and date string used in the error and
log files. A percent symbol specifies the start of a code for displaying a specific
value. All other characters used in the format string specify the time and date
string.
Format Description

%a Abbreviated weekday name

%A Full weekday name

%b Abbreviated month name

%B Full month name

%c Date and time representation appropriate for the locale

%d Day of the month as a decimal number (01-31)

%H Hour in 24-hour format (00-23)

%I Hour in 12-hour format (01-12)

%j Day of the year as a decimal number (001-366)

%m Month as a decimal number (01-12)

%M Minute as a decimal number (00-59)
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%p Current locale’s AM/PM indicator for a 12-hour clock

%S Second as a decimal number (00-59)

%w Weekday as a decimal number (0-6; Sunday is 0)

%x Date representation for current locale

%X Time representation for current locale

%y Year without the century as a decimal number (00-99)

%Y Year with the century as a decimal number

%Z Time zone name or abbreviation

%% Percent sign
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[ssc-logger] Section Settings
The [ssc-logger] section contains settings that specify how the compiler notify
you of errors. It can contain the following settings:

SpawnDisplay=<0> or <1> or <2>
Default: 0

Purpose: Specifies what to do with the error file when the compiler is finished.
A zero means do nothing. A value of one starts up the application specified in
DisplayTool to show the error file at the end of the compilation, if there are
errors in the compilation. A value of two always starts up the application speci-
fied in DisplayTool at the end of a compilation to show the error file.

DisplayTool=<application name>
Default: NOTEPAD.EXE
Indicates the application used to display the error file at the end of a compila-
tion. The compiler uses a command line in the following the form:
Application ErrorFile

Level=<0> or <1>
Default: 0

Purpose: Specifies the level of logging. Zero specifies error logging. Only
errors are written to the error file. A value of one specifies full logging. In
addition to errors, each tool encountered is written to the error file.
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[ssc-generate] Section Settings
The [ssc-generate] section contains settings that affect how the compiler gener-
ates certain aspects of Quick Panel objects. These changes are mostly cosmetic,
a few settings can impact run-time performance. The [ssc-generate] section can
contain the following settings:

LegendGeneration=<0> or <1>
Default: 0

Purpose: When the value is zero, legend plates are generated as chamfered
rectangles. Although they can be distinguished easily, they tend to draw more
slowly than normal rectangles, and slow panel changes. When set to one, legend
plates are drawn as simple rectangles, improving the draw speed and the panel
change times.

NumericDataGeneration=<0> or<2> or <3>
Default: 0

Purpose: Changes the appearance of the dynamic data portion of objects
containing dynamic data. When the value is zero, the number of digits in the
dynamic data field is extended so that the field covers the entire width of the
Quick Panel object. When the value is two or three, the number of digits is held
to the value specified in the panel object’s dialog box.

Since this value may be less than the actual width of the panel object, two
options exist for presentation. When the value is two, the dynamic data field is
always centered within the panel object. When the value is three, the dynamic
data field is justified within the panel object using the justification specified in
the dialog box.

TextDataGeneration=<0> or <2> or <3>
Default: 0

Purpose: Changes the appearance of the dynamic text portion of objects con-
taining dynamic text. When the value is zero, the number of characters in the
dynamic text field is extended so that the field covers the entire width of the
Quick Panel object. When the value is two or three, the number of characters is
held to the value specified by the user in the panel object’s dialog box.

Since this value may be less than the actual width of the panel object, two
options exist for presentation. When the value is two, the dynamic text field is
always centered within the panel object. When the value is three, the dynamic
text field is justified within the panel object using the justification specified in
the dialog box.
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Sample SSC.INI File
A sample SSC.INI file is shown below.

[ssc-option]
Sound=1
TDFormat=%y-%m-%d %H:%M %Z
[ssc-logger]
DisplayTool=notepad
SpawnDisplay=1
Level=1
[ssc-generate]
LegendGeneration=1
NumericDataGeneration=2
TextDataGeneration=3

The sample does the following:

• Turns on the sound so that the compiler provides audible indication of it’s
current progress.

• Formats the time and date string in the error/log file to produce strings
formatted as follows: 94-05-04 08:21 cdt.

• Displays the error/log file at the end of a compile in notepad only if there are
errors.

• Notifies you each time the compiler encounters an error, halting compilation
till you acknowledge the error.

• Generates legend plates as simple rectangles.

• Specifies that Quick Panel objects that contain numeric data fields more
narrow than the object maintain the user specified size of the data fields. All
such fields are centered horizontally in the Quick Panel object.

• Specifies that Quick Panel objects that contain text data fields more narrow
than the object maintain the user specified size of the data fields. All such
fields are justified horizontally within the Quick Panel object according to
the justification specified for the text.
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Quick Panel Error Messages
When an error occurs in the Quick Panel display during run mode, it displays an
error message. The following list explains the origin of the problem behind each
error message along with appropriate ways of correcting it. After a problem has
been solved, turn the power off, then on, and restart the Quick Panel display.

There is a priority system in displaying error messages. When a system error
occurs, the message System Error displays before any other messages. For errors
other than system error, Quick Panel displays the message for the most recent
error. After resolving the error, the error message remains on the screen until you
choose another panel or reset the unit.

The error messages listed below may appear on the Quick Panel unit. Instruc-
tions on how to find and solve error messages are explained on the following
pages.

SYSTEM ERROR
Indicates a fault in the basic operations of the Quick Panel. Following the error
message, an error code, as shown, will appear.

SYSTEM ERROR ( 03: x x )
Displays when a PC transferred file cannot be rebuilt. The x x portion of the
message indicates the error number.

SYSTEM ERROR ( x x x : x x x : x x x )
Displays in RUN mode when a file cannot be rebuilt. The message shows the
error numbers in sequence.

ILLEGAL ADDRESS IN SCREEN DATA
Caused by an overlap of addresses. Following the error message, error codes, as
listed below, appear. If the error cannot be fixed, please report the error code and
details on how the error developed to the Quick Panel technical support team.

ILLEGAL ADDRESS IN SCREEN DATA ( 0 0 B: x x x : x x x )
Overlapping Addresses

Error 1 Error 2 Contents

191 All or part of the T-File or S-tag address range
OC1 192 overlap the addresses of System Data Area.

193

194 All or part of the System Data Area address, A-File,
0C2 195 or S-tag address range overlap the addresses setup in

196 a

197 All or part of the T-File, or the S-tag or K-tag address
0C3 198 range overlap the address range set in an A-file.

199

UNSUPPORTED TAG IN SCREEN DATA
Lists tag(s) in use that are unsupported by the current Quick Panel version
appear. Change the tags to ones that are supported.

PLC NOT CONNECTED
There is a transmission time-out error. Check the cable wiring and connect
correctly.

PLC NOT RESPONDING
There is a Reply Time-out Error. The origin of the problem and the solutions are
listed below.
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1. The power for the controller host is not  activated.  Turn on the controller.

2. Quick Panel unit INITIALIZE setup (Setup l/O) is incorrect. Setup the unit
correctly and match up with the current host and Communication Cable.

3. The controller and Quick Panel power up process was incorrect. Turn the
controller’s power on first, wait 2-3 seconds, then power up the Quick Panel
display.

4. The Communication Cable was not connected properly. Check the Commu-
nication Cable wiring and connect it up properly.

RECEIVE DATA ERROR
The Quick Panel display is not receiving data. This error occurs when the
communication cable is pulled out when the Quick Panel display is on. Or when
normal communication operations are being run, but the Quick Panel display has
been powered off, then back on. Begin running transmissions again.

PLC COM. ERROR ( 02: X X )
• The address setup for tags exceeds the address range on the host side.
Check the error number that appears and use the following table to eradicate the
problem. The XX portion of the message is the error code.

• Error FC: The communication settings for this unit and the host do not
match. Fix the SI0 communication settings to match the host.

• Error 66: The address set on a tag, or the address set by an alarm message is
out of a set range. (address range error).

SCREEN MEMORY CHECKSUM ERROR
The checksum of the screen memory data does not match because of a corrup-
tion in the screen files. Error codes follow the error message, SCREEN
MEMORY DATA IS CORRUPT ( x x x x : x x x x). By referring to the error
code, check the screens that have errors. When a screen file has been corrupted,
delete that file, and make a new one or recall a backup copy if available.

SCREEN MEMORY DATA IS CORRUPT ( x x x x : x x x x)
The first error code is the Screen Number that has an error (displays only one
Screen Number). The second code is the number of screens that have errors
(Decimal).

CLOCK SET UP ERROR
The backup battery for the internal clock is dead. The battery needs to be
replaced. Please contact technical support for service. After changing the backup
battery, set up the internal clock.

The life span of the backup battery depends on the ambient temperature and the
amount of current being charged and used. The table below gives a general
indication of how long the battery will last.

Battery Temperature under 40 C 40~ 50 C 50~ 60 C
Expected  Life Span over 10 yrs. over 4.1 yrs. over 1.5 yrs.

SCREEN TRANSFER ERROR
An error occurred in the data transmission from the screen editor to the Quick
Panel. Try retransmitting the screen data.
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Quick Panel Character Map
The Quick Panel has a built-in character set. Many of the special characters
available in the character set cannot be entered directly from the keyboard. An
easy way to enter the special characters is to open the Windows program Char-
acter Map. Select Terminal for the Font. Select a character and the associated
Keystroke code is shown in the lower right corner of the dialog box.

NOTE: The characters shown in the terminal character map may not be the
same as those in the Quick Panel. In most cases, the characters are
the same. The correct characters and codes are shown in the table
below. Where no codes are shown, the character is a standard key-
board character.

To enter a special character

1. Locate the character and the associated code in the table.

2. Find the character in the terminal character map that has the same code and
highlight it with the mouse.

3. Click the Select button then the Copy button. The character code is now on
your clipboard.

4. Paste the character into a text field in Quick Designer.

The character will not appear the same as the one in the table, but it will
appear correctly when the code is downloaded to the Quick Panel.

To create words:

1. Highlight a character then click the Select button.

2. Continue choosing characters until you have selected all the characters.

3. Click the Copy button to copy all codes to the clipboard.
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The following table shows the character map.

Char Code Char Code Char Code
! Keyboard “ Keyboard # Keyboard

$ Keyboard % Keyboard & Keyboard
‘ Keyboard ( Keyboard ) Keyboard
* Keyboard + Keyboard , Keyboard
- Keyboard . Keyboard / Keyboard
0 Keyboard 1 Keyboard 2 Keyboard
3 Keyboard 4 Keyboard 5 Keyboard

6 Keyboard 7 Keyboard 8 Keyboard
9 Keyboard : Keyboard ; Keyboard
< Keyboard = Keyboard > Keyboard
? Keyboard @ Keyboard A Keyboard
B Keyboard C Keyboard D Keyboard
E Keyboard F Keyboard G Keyboard

H Keyboard I Keyboard J Keyboard
K Keyboard L Keyboard M Keyboard
N Keyboard O Keyboard P Keyboard
Q Keyboard R Keyboard S Keyboard
T Keyboard U Keyboard V Keyboard
W Keyboard X Keyboard Y Keyboard

Z Keyboard [ Keyboard \ Keyboard
] Keyboard ^ Keyboard _ Keyboard
‘ Keyboard a Keyboard b Keyboard
c Keyboard d Keyboard e Keyboard
f Keyboard g Keyboard h Keyboard

i Keyboard j Keyboard k Keyboard
l Keyboard m Keyboard n Keyboard
o Keyboard p Keyboard q Keyboard
r Keyboard s Keyboard t Keyboard
u Keyboard v Keyboard w Keyboard
x Keyboard y Keyboard z Keyboard

{ Keyboard | Keyboard } Keyboard



E-4 Quick Designer User Guide

Control Technology Corporation proprietary, Reproduction or distribution forbidden.

Quick Panel Character Map

Char Code Char Code Char Code
~ Keyboard � Ctrl+| � Ctrl+2
� Alt+0129 � Alt+0130 � Alt+0131
� Alt+0132 � Alt+0133 � Alt+0134
	 Alt+0135 
 Alt+0136 � Alt+0137
� Alt+0138 
 Alt+0139 � Alt+0140
� Alt+0141 � Alt+0142 � Alt+0143

� Alt+0144 � Alt+0145 � Alt+0146
� Alt+0147 � Alt+0148 � Alt+0149
� Alt+0150 � Alt+0151 � Alt+0152
� Alt+0153 � Alt+0154 ø Alt+0155
� Alt+0156 Ø Alt+0157 x Alt+0158
ƒ Alt+0159 á Alt+0160 ❡ Alt+0161

❢ Alt+0162 � Alt+0163 � Alt+0164
 Alt+0165 Alt+0166 Alt+0167
! Alt+0168 ® Alt+0169 ✦ Alt+0170
" Alt+0171 # Alt+0172 ✶ Alt+0173
✺ Alt+0174 ✵ Alt+0175 $ Alt+0176
% Alt+0177 & Alt+0178 ' Alt+0179
� Alt+0180 Á Alt+0181 Â Alt+0182

À Alt+0183 © Alt+0184 ( Alt+0185

) Alt+0186 * Alt+0187 + Alt+0188
¢ Alt+0189 ¥ Alt+0190 , Alt+0191
- Alt+0192 . Alt+0193 / Alt+0194
0 Alt+0195 � Alt+0196 1 Alt+0197
ã Alt+0198 Ã Alt+0199 2 Alt+0200
3 Alt+0201 4 Alt+0202 5 Alt+0203

6 Alt+0204 7 Alt+0205 8 Alt+0206
¤ Alt+0207 ó (2) Alt+0208 Ð Alt+0209
Ê Alt+0210 Ë Alt+0211 È Alt+0212
" Alt+0213 Í Alt+0214 Î Alt+0215
Ï Alt+0216 9 Alt+0217 : Alt+0218
; Alt+0219 < Alt+0220 ¦ Alt+0221



Quick PanelCharacter Map E-5

Control Technology Corporation proprietary, Reproduction or distribution forbidden.

Char Code Char Code Char Code
Ì Alt+0222 = Alt+0223 Ó Alt+0224
> Alt+0225 Ô Alt+0226 Ò Alt+0227
õ Alt+0228 Õ Alt+0229 µ Alt+0230
Þ Alt+0231 þ Alt+0232 ú Alt+0233
û Alt+0234 ù Alt+0235 ý Alt+0236
Ý Alt+0237 ¯ Alt+0238 ' Alt+0239

¯ Alt+0240 ± Alt+0241 = Alt+0242
¾ Alt+0243 ¶ Alt+0244 § Alt+0245
? Alt+0246 ˜ Alt+0247 @ Alt+0248
¨ Alt+0249 A Alt+0250 ¹ Alt+0251
³ Alt+0252 ² Alt+0253 B Alt+0254
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Index
Symbols
~System_Comm_Status  1-20, B-4
~System_Contrast  1-20, B-3
~System_Day  1-19, B-2
~System_Hour  1-19, 6-32
~System_Minute  1-19, 6-32
~System_Month  1-19, B-2
~System_Second  1-19, 6-32
~System_Year  1-19, B-2

A
Add Folder dialog box  3-4
Adding

library objects  3-6
tags  1-17

auto button  1-17
Additional Project Setup dialog box  1-4
Advanced Alarm Settings dialog box  4-6, 4-9
Alarm Configuration dialog box  4-4, 4-8
Alarm Queue Configuration dialog box  4-5, 4-9
Alarm Queue Settings dialog box  4-4, 4-9
Alarm Window Settings dialog box  4-12
Alarms

bit alarm table  4-7
checking alarm panel  4-14
configuring  4-4
creating an alarm message window  4-12
creating an alarm table

using bit alarms  4-7
entering messages  4-10
formatting messages  4-4
introduction to  4-2
selecting configuration options  4-8
setting up

initial state  4-6
notification tags  4-6
system queues  4-4

system queues  4-4
testing alarm panel  4-14
using in Quickstep  4-11
using with a bar graph  6-34
using with keypads  7-3
window  4-2

Aligning
panel objects  2-6

Analog meter display  6-42
creating  6-42
degrees shown in  6-42
orientation  6-42

B
Bar graph  6-34

creating  6-35
face plate  6-34
orientation  6-34
scale values  6-34
setting alarms  6-34

Bar Graph Settings dialog box  6-35
Beeper

disabling  1-6

Bitmap
bitmap tool  5-6
creating  5-6
images on panel  5-6
size  5-6

Bitmap Settings dialog box  5-6
Browser properties  3-3
Browser Properties dialog box  3-3

C
Changing

panel object tags  2-6
window view  2-5

Character map
for Quick Panel display  E-2

Circle
circle tool  5-8
creating objects  5-8
moving objects  5-8
sizing objects  5-8

Clock  1-19
Clock display  6-32

creating  6-32
setting up numeric data entry  6-32

Communications protocol
status  B-4

Compiling
generation options  C-2
panels

for downloading  8-5
tools used for  8-2

Creating
alarm messages  4-10
alarm table

using bit alarms  4-7
analog meter displays  6-42
bar graph  6-35
bar graphs  6-34
bitmaps  5-6
circles  5-8
clock display  6-32
goto panel push button  6-13
illuminated push buttons  6-2
library objects  3-6
local image display  6-30
local message display  6-25
numeric data displays  6-8
numeric data entry button  6-11
pilot light  6-21, 6-22

circular  6-23
standard  6-22

polygons  5-2
polyline drawings  5-2
print button  6-46
push buttons  6-5
rectangles  5-10
selector switch  6-15
tags  1-17
text blocks  5-5
trend display  6-38
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video display  6-48, 6-50
word button  6-18

D
Date

system variables for  B-2
Default settings  2-13
Defining

passwords  1-8
Deleting

panel objects  2-3
tags  1-17

Dialog box
Add Folder  3-4
Additional Project Setup  1-4
Advanced Alarm Settings  4-6, 4-9
Alarm Configuration  4-4, 4-8
Alarm Queue Configuration  4-5, 4-9
Alarm Queue Settings  4-4, 4-9
Alarm Window Settings  4-12
Bar Graph Settings  6-35
Bitmap Settings  5-6
Browser Properties  3-3
Display Configuration  1-5
Goto Panel  2-10
Goto Panel Button Settings  6-13
Grid Settings  2-13
Illuminated Push Button Settings  6-3
Keypad Assignment  2-9
Line/Polyline/Polygon Settings  5-4
Local Image Display  6-31
Local Message Display  6-25
Meter Settings  6-42
Modify Tag Attributes  2-6
New Project  1-4
New Word Alarms  4-7
Numeric Data Display Settings  6-8
Numeric Data Entry Settings  6-11, 6-32
Password Setting  1-8
Pilot Light Settings  6-22
Print Button Settings  6-46
Project Setup  1-4
Push Button Settings  6-5
Quick Manager  1-4
Rectangle Settings  5-10
Report Setup  2-14
Selector Switch Settings  6-15
Serial Parameters  1-6
System Configuration  1-7
Tag Attributes  1-18
Text Settings  5-5
Time Display Settings  6-33
Touch Screen Configuration  1-6
Transfer Library Object  3-6, 3-7
Trend Graph Settings  6-39
Word Button Settings  6-19

Disabling
beeper  1-6

Display Configuration dialog box  1-5

Display contrast
Quick Panel  B-3

Downloading
communication problems  8-7
compiling panels  8-5
connection to Quick Panel  8-4
files included  8-2
target display condition  8-4
tools used for  8-2
troubleshooting guide  8-7

Drawing grid  2-13
Drawing snap system  2-13

E
Editing

panel objects  2-3
polyline object

nodes  5-3
Entering

alarm messages  4-10
numeric data  6-10

Error messages
Quick Panel  D-2

Exporting
local message display  6-28
panels  2-5
tags  1-18

F
Flashing colors

dimming  2-8
Folder  3-4

G
Goto Panel Button Settings dialog box  6-13
Goto Panel dialog box  2-10
Goto panel push button  6-13

creating  6-13
Grid Settings dialog box  2-13
Grouping

panel objects  2-3, 2-6

I
Illuminated push button  6-2

creating  6-2
Illuminated Push Button Settings dialog box  6-3
Importing

local message display  6-26
panels  2-5
tags  1-18

Internal tags  1-19
system variables  1-19, 6-32, B-2



Index-4
Control Technology Corporation proprietary. Reproduction or distribution forbidden.

Quick Designer User Guide

Index

K
Keypad  1-6

assignments  2-9, 7-5
layout  7-2
programmable keys  7-2
reserved keys  7-2
simulating panel objects  7-4

creating  7-4
tag display  2-4
using for data entry  7-3
using with alarms  7-3

L
Library Browser

folders
deleting  3-4
properties  3-4
transferring objects  3-4

objects
creating  3-6
deleting  3-5
properties  3-5
transferring  3-5

properties
appearance  3-3
drag 'n drop  3-3

window  3-2
Line/Polyline/Polygon Settings dialog box  5-4
Local image display  6-29

creating  6-30
design strategies  6-29
specifying register values or bits  6-30
states

introduction  6-29
specifying  6-30

Local Image Display dialog box  6-31
Local message display  6-25

creating  6-25
exporting  6-28
importing  6-26

Local Message Display dialog box  6-25

M
Meter Settings dialog box  6-42
Modify Tag Attributes dialog box  2-6
Modifying

tag attributes  2-6
Moving

polyline object  5-2
rectangle object  5-10
text object  5-5

N
New Project dialog box  1-4
New Word Alarms dialog box  4-7
Nodes

on line segments  5-2
Numeric data display  6-8

creating  6-8
Numeric Data Display Settings dialog box  6-8

Numeric data entry button  6-10
creating  6-11

Numeric Data Entry Settings dialog box  6-11, 6-32

P
Panel

adding bitmaps  5-6
adding text  5-5
aligning objects  2-6
analog meter display  6-42
bar graph display  6-34
basic panel operators  1-13
changing object appearance  C-2
changing object tags  2-6
changing settings  2-8
checking for errors  2-5
clock display  6-32
exporting  2-5
goto panel push button  6-13
grouping objects  2-3, 2-6
ID  2-5
illuminated push button  6-2
importing  2-5
local image display  6-29

states  6-29
local message display  6-25
numeric data display button  6-8
numeric data entry  6-10
operator

analog meter display  6-42
bar graph  6-34
bitmaps  5-6
circles  5-8
clock display  6-32
core components  1-14
goto panel push button  6-13
illuminated push button  6-2
local image display  6-29
local message display  6-25
numeric data display  6-8
numeric data entry button  6-10
pilot light  6-21
polygons  5-2
print button  6-45
push button  6-5
rectangles  5-10
selector switch  6-15
text block  5-5
trend display  6-38
word button  6-18

pilot light  6-21
polyline drawing  5-2
previewing  2-5
print button  6-45
push button  6-5
saving  2-5
selector switch  6-15
sizing objects  2-3
time-out duration

setting  1-7
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trend display  6-38
trigger tag  1-7
ungrouping objects  2-6
word button  6-18

Part objects  2-11
Password

defining  1-8
Password Setting dialog box  1-8
Pilot light  6-21

circular  6-21
creating  6-23

creating  6-22
standard  6-21

creating  6-22
Pilot Light Settings dialog box  6-22
Polyline

editing nodes  5-3
moving objects  5-2
polyline tool  5-2
settings  5-4
sizing objects  5-3

Preferences
setting  2-7

Previewing
panels  2-5

Print button  6-45
creating  6-46
specifying appearance  6-45

Print Button Settings dialog box  6-46
Project

naming  1-4
report  2-14

alarm information  2-16
panel information  2-15
project information  2-14
tag information  2-15

Project Setup dialog box  1-4
Purge  1-18
Push button  6-5

creating  6-5
goto panel  6-13

creating  6-13
illuminated  6-2

creating  6-2
Push Button Settings dialog box  6-5

Q
Quick Courier  8-2
Quick Designer

toolbar buttons  1-10
toolbox design tools  1-11
window  1-10

Quick Manager  1-2
dialog box  1-4
menu buttons  1-3
project file list  1-3
status bar  1-3
toolbar buttons  1-2

Quick Panel
adjusting display contrast  B-3
changing panel object appearance  C-2
character map  E-2
error messages  D-2

R
Rectangle

creating  5-10
moving objects  5-10
rectangle tool  5-10
sizing objects  5-10

Rectangle Settings dialog box  5-10
Report Setup dialog box  2-14

S
Saving

panels  2-5
Selecting

communications parameters  1-6
video display channels  6-48

Selector switch  6-15
creating  6-15

Selector Switch Settings dialog box  6-15
Serial Parameters dialog box  1-6
Setting

panel time-out duration  1-7
preferences  2-7

Sizing
panel objects  2-3

Specifying
tag attributes  1-18

System
tags  1-19
variables  1-19

clock display  6-32
communication protocol status  B-4
date stamp  B-2
display contrast  B-3

System Configuration dialog box  1-7

T
Tag Attributes dialog box  1-18
Tags

adding
auto button  1-17

adding tags  1-17
attributes  1-18
deleting  1-17
displaying

tags window  1-16
exporting  1-18
importing  1-18
internal tags  1-19

system variables  1-19
introduction  1-16
object tag display  2-4
panel trigger tag  1-7
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system tags  1-19
clock  1-19
communication status  1-20
contrast  1-20
date  1-19

tags window  1-16
validating  1-18

Text
adding

with text tool  5-5
moving  5-5

Text Settings dialog box  5-5
Tiling and drawing grids  2-11
Tiling grid

for objects  2-12
snap system  2-12

Time Display Settings dialog box  6-33
Time-out duration  1-7
Toolbar

Quick Designer  1-10
Quick Manager  1-2

Toolbox design tools
Quick Designer  1-11

Tools
circle  5-8
polyline  5-2
rectangle  5-10
text tool  5-5

Touch grid  2-11
Touch Screen Configuration dialog box  1-6
Transfer Library Object dialog box  3-6, 3-7
Trend display  6-38

creating  6-38
parameters  6-38

Trend Graph Settings dialog box  6-39
Troubleshooting guide

for downloading  8-7

U
Ungrouping

panel objects  2-6

V
Validating

tags  1-18
Variables

system  1-19
clock display  6-32
communication protocol status  B-4
date stamp  B-2
display panel contrast  B-3

Video display  6-48
creating  6-50
selecting channels  6-48

Index

W
Word button  6-18

creating  6-18
setting action  6-18
specifying mode  6-18

Word Button Settings dialog box  6-19


